A PROPOSED SUBMARINE ELECTRONIC CHART DISPLAY AND INFORMATION SYSTEM

JAMES ALLAN CLARKE

September 1999
A PROPOSED SUBMARINE ELECTRONIC CHART DISPLAY AND INFORMATION SYSTEM

James Allan Clarke

Department of Geodesy and Geomatics Engineering
University of New Brunswick
P.O. Box 4400
Fredericton, N.B.
Canada
E3B 5A3

September 1999

© James Allan Clarke, 1999
PREFACE

In order to make our extensive series of technical reports more readily available, we have scanned the old master copies and produced electronic versions in Portable Document Format. The quality of the images varies depending on the quality of the originals. The images have not been converted to searchable text.
PREFACE

This technical report is an unedited reproduction of a report submitted in partial fulfillment of the requirements for the degree of Master of Engineering in the Department of Geodesy and Geomatics Engineering, June 1999. This work was supported by the Canadian Department of National Defence and by Universal Systems Limited. The research was supervised by Drs. David Wells and David Coleman.

As with any copyrighted material, permission to reprint or quote extensively from this report must be received from the author. The citation to this work should appear as follows:

ABSTRACT

The introduction of electronic charts and their display systems has greatly improved the mariner's ability to absorb information and assess developing navigation and collision avoidance situations. NATO, recognizing the capability of these systems, has commenced development of a specialized navigation system that will extend the role of conventional ECDIS into the warship environment. This report proposes a further extension of ECDIS capabilities into the submarine environment, thus providing the modern submariner with the benefits of computer assisted navigation.

The unique requirements of submarine navigation, the S-57 Electronic Navigational Chart, and the Vector Product Format's Digital Nautical Chart are investigated. Additional requirements needed for a specialized Submarine Electronic Chart Display and Information System are then proposed and recommendations for the most suitable electronic chart product are made. A proposed product specification is included as an Appendix to the report.

Review of submarine navigation identifies four new functional requirements that must be added to WECDIS to support submarine navigation. The new requirements are: real time pool of errors generation; real time generation of safe depth contours; input, display and organization of water space management data; and the ability to function as a digital local operations plot. After review of the two prominent electronic charts, the Digital Nautical Chart is selected as the most suitable product for use.
Acknowledgements

I would like to express my appreciation to the Department of National Defence for their sponsorship and support during my time at UNB. I would like to thank Marty Dussault and Luc Pelletier who made it possible for me to attend UNB. I thank Dave Hudock who taught me how to be a professional.

I would also like to thank Dr. D. Wells and Dr. D. Coleman for their support, guidance, and enthusiasm in this project.

Universal Systems Limited provided generous software and training support, without which this project would not have been possible – thanks.

I thank my wife Huguette. Over the years we have had precious little time together; these last two years have been a rare exception. In the face of difficult circumstances you have managed to be a loving mother and provide tremendous support to me. Your contribution these last two years was enormous.

Finally to my children Katherine and Christopher: I dedicate this work to you...
# Table of Contents

ABSTRACT .................................................................................................................................II

ACKNOWLEDGEMENTS ...................................................................................................................III

LIST OF TABLES .............................................................................................................................VII

LIST OF FIGURES ............................................................................................................................VIII

LIST OF ABBREVIATIONS ..................................................................................................................X

INTRODUCTION ......................................................................................................................................1

1.1 General ........................................................................................................................................... 1

1.2 Situational Awareness .................................................................................................................... 3

1.3 Digital Data Standards ................................................................................................................... 6

1.4 WECDIS Concept ........................................................................................................................... 8

1.5 ENC / DNC ..................................................................................................................................... 12

1.6 The Problem ................................................................................................................................ 15

1.7 Methodology ................................................................................................................................ 16

REQUIREMENTS FOR A SUBMARINE ECDIS .............................................................................17

2.1 Introduction .................................................................................................................................... 17

2.2 The Pool of Errors .......................................................................................................................... 17

2.3 3-D Navigation ............................................................................................................................... 20

2.4 Waterspace Management ............................................................................................................... 23

2.5 The Digital Local Operations Plot .................................................................................................. 24

2.5.1 The LOP and Visual Attacking ................................................................................................. 25

2.5.2 The LOP and Blind Attacking ................................................................................................. 26

2.6 A Future for SECDIS? .................................................................................................................... 28

THE S-57 ELECTRONIC NAVIGATIONAL CHART ........................................................................30

3.1 Introduction .................................................................................................................................... 30
## List of Tables

<table>
<thead>
<tr>
<th>Table</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>4-1</td>
<td>DNC Tile Dimensions</td>
<td>68</td>
</tr>
<tr>
<td>4-2</td>
<td>Layering Schema for Author's DNC Production</td>
<td>76</td>
</tr>
<tr>
<td>D-1</td>
<td>Isolated/Connected Node Primitive Table</td>
<td>110</td>
</tr>
<tr>
<td>D-2</td>
<td>Edge Primitive Table</td>
<td>110</td>
</tr>
<tr>
<td>D-3</td>
<td>Face Primitive Table</td>
<td>110</td>
</tr>
<tr>
<td>D-4</td>
<td>Ring Table</td>
<td>110</td>
</tr>
<tr>
<td>D-5</td>
<td>A Simple Feature Table</td>
<td>111</td>
</tr>
<tr>
<td>D-6</td>
<td>Join Table</td>
<td>111</td>
</tr>
<tr>
<td>D-7</td>
<td>Feature Class Schema Table</td>
<td>111</td>
</tr>
<tr>
<td>D-8</td>
<td>Value Description Table</td>
<td>111</td>
</tr>
</tbody>
</table>
## List of Figures

<table>
<thead>
<tr>
<th>Figure</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-1</td>
<td>Classification Scheme for Electronic Chart Data</td>
<td>13</td>
</tr>
<tr>
<td>2-1</td>
<td>A Pool of Errors</td>
<td>20</td>
</tr>
<tr>
<td>2-2</td>
<td>Portion of a Dived Chart</td>
<td>22</td>
</tr>
<tr>
<td>2-3</td>
<td>A LOP Solution</td>
<td>26</td>
</tr>
<tr>
<td>2-4</td>
<td>LOP Zig Procedure</td>
<td>27</td>
</tr>
<tr>
<td>3-1</td>
<td>The S-57 Data Model</td>
<td>32</td>
</tr>
<tr>
<td>3-2</td>
<td>The Vector Model</td>
<td>34</td>
</tr>
<tr>
<td>3-3</td>
<td>Chain-Node Topology</td>
<td>36</td>
</tr>
<tr>
<td>3-4</td>
<td>The ENC Data Model</td>
<td>37</td>
</tr>
<tr>
<td>3-5</td>
<td>Layered Representation of Reality</td>
<td>39</td>
</tr>
<tr>
<td>3-6</td>
<td>Exchange Set Hierarchy</td>
<td>40</td>
</tr>
<tr>
<td>3-7</td>
<td>ENC Data Structure</td>
<td>44</td>
</tr>
<tr>
<td>3-8</td>
<td>The Header Listing</td>
<td>49</td>
</tr>
<tr>
<td>3-9</td>
<td>Coincident Line Geometry</td>
<td>51</td>
</tr>
<tr>
<td>3-10</td>
<td>The HOM Screen Layout</td>
<td>53</td>
</tr>
<tr>
<td>3-11</td>
<td>Attribute Interface</td>
<td>55</td>
</tr>
<tr>
<td>3-12</td>
<td>Missing Mandatory Attribute</td>
<td>56</td>
</tr>
<tr>
<td>3-13</td>
<td>Depth Area Lines</td>
<td>56</td>
</tr>
<tr>
<td>Figure</td>
<td>Title</td>
<td>Page</td>
</tr>
<tr>
<td>--------</td>
<td>------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>4-1</td>
<td>DNC Boundaries</td>
<td>64</td>
</tr>
<tr>
<td>4-2</td>
<td>VPF Structure Levels</td>
<td>65</td>
</tr>
<tr>
<td>4-3</td>
<td>Feature Structural Schema</td>
<td>66</td>
</tr>
<tr>
<td>4-4</td>
<td>VPF Implementation</td>
<td>74</td>
</tr>
<tr>
<td>4-5</td>
<td>DNC File Structure</td>
<td>81</td>
</tr>
<tr>
<td>A-1</td>
<td>Unregistered Vector Chart</td>
<td>97</td>
</tr>
<tr>
<td>A-2</td>
<td>Registered Vector Chart</td>
<td>97</td>
</tr>
<tr>
<td>A-3</td>
<td>Results of Automatic &quot;Features to Objects&quot;</td>
<td>98</td>
</tr>
<tr>
<td>A-4</td>
<td>Final ENC</td>
<td>98</td>
</tr>
<tr>
<td>B-1</td>
<td>Digitize Data Workflow (ENC)</td>
<td>100</td>
</tr>
<tr>
<td>B-2</td>
<td>File Preparation Workflow (ENC)</td>
<td>101</td>
</tr>
<tr>
<td>B-3</td>
<td>Digitize Data Workflow (DNC)</td>
<td>102</td>
</tr>
<tr>
<td>B-4</td>
<td>File Preparation Workflow (DNC)</td>
<td>103</td>
</tr>
</tbody>
</table>
List of Abbreviations

ANI    Auxiliary Navigation Information
ARPA  Automatic Radar Plotting Aid
CARISTM Computer Aided Resource Information System (A registered USL software product)
CEDD  Committee for the Exchange of Digital Data (IHO committee established 1983)
CHS   Canadian Hydrographic Service
CNI   Core Navigation Information
CPA   Closest Point of Approach
DGIWG Digital Geographic Information Working Group (11 nation NATO working group)
DIGEST Digital Geographic Information Exchange Standard (NATO exchange standard)
DMA   Defense Mapping Agency
DNC   Digital Nautical Chart (A VPF product)
DOM   DIGEST Object Manager (A USL software product)
DR    Dead Reckoning
ECDIS Electronic Chart Display and Information System
ENC   Electronic Navigational Chart (An S-57 product)
EP    Estimated Position
FACC  Feature and Attribute Coding Catalog (A DIGEST document)
HOM   Hydrographic Object Manager (A USL software product)
IEC   International Electrotechnical Committee
IHO   International Hydrographic Organization
IMO   International Maritime Organization
ISO   International Organization for Standards
LOP   Local Operations Plot
NATO  North Atlantic Treaty Organization
NIMA  National Imagery and Mapping Agency
S - 52 Specifications for Chart Content and Display Aspects of ECDIS, Special Publication No. 52
S - 57 Transfer Standard for Digital Hydrographic Data, Special Publication No. 57
SAMI  Semi Automated Map Input (A module within CARIS)
SECDIS Submarine Electronic Chart Display and Information System
SOLAS Safety of Life at Sea
USL   Universal Systems Limited
VPF   Vector Product Format (Exchange Standard developed by DMA)
VRF   Vector Relational Format (An exchange standard within DIGEST)
WECDIS Warship Electronic Chart Display and Information System
WSM   Water Space Management
Introduction

1.1 General

The integration of computer and chart has revolutionized modern surface navigation. However, this technology has not been extended to submarine navigation. This “oversight” means that, while surface fleets enjoy the benefits of automated navigation, submarine services will continue to navigate in a “paper world”. Paper navigation is safe and effective, but modern computerized systems automate several time-consuming “paper world” tasks thus providing the mariner with accurate information in real time. Extension of this technology to a dedicated submarine navigation system would allow the modern submariner to enjoy many of the benefits of electronic navigation. Requirements for such a system are proposed in this report.

The combination of sensor and navigation information reduces workload and stress on the bridge team, while improving safety at sea. The development of this technology is the result of much effort and, while certain product specifications have been certified as “paper equivalent”, much work remains. Of particular interest is the use of this technology in military vessels. Traditionally, naval vessels have carried a combination of charts, some produced by government hydrographic offices, and other [classified] charts produced by military agencies. Member nations within the North Atlantic Treaty Organization (NATO) face several difficult challenges during the transition from paper to electronic charts. Using their own Digital Geographic Information Exchange Standard (DIGEST) provides enhanced usability in a military environment by allowing layer creation (thus providing at sea forces with some of the advantages realized within a Geographic Information System), and integration with other
DIGEST compliant maps (for combined operations). The International Hydrographic Organization (IHO) has developed a “purpose built” data exchange standard and associated product specification used by hydrographic organizations throughout the world to produce electronic charts.

An underlying problem facing NATO nations is that the producers of most hydrographic data in the world are producing data in a format consistent with the needs of civilian mariners. Limiting military vessels to this format would restrict the scope of a warship ECDIS to navigation, when the capability exists to produce a complete Command and Control system. NATO is in the early stages of developing a Warship Electronic Chart Display and Information System (WECDIS) that expands on ECDIS technology to create a complete Command and Control system. WECDIS can potentially provide a vast improvement in navigation, anti-collision, and command and control to the surface navies of NATO while using S-57 Electronic Navigational Charts (ENCs), DIGEST Digital Nautical Charts (DNCs), or some other format. Unfortunately, this concept was not extended to submarine navigation, and this shortcoming has not been addressed within NATO (or anywhere else in the public domain). As the Canadian Navy charts a digital course into the future, our new submarines may be outdated navigationally before entering service.

The Canadian Navy has committed to the use of DNCs [Kennedy, 1998], and worldwide coverage is expected by 2002 [NIMA, 1999]. In return for the use of the National Imagery and Mapping Agency’s (NIMA) worldwide DNC database, Canada has entered into a production partnership with them, producing all national charts and charts from regions within the Caribbean. The Canadian approach to production has been
simple: where national charts do not or will not exist, we have produced DNCs from
scratch; where national charts exist, or will exist in digital form, ENC is converted into
DNCs. The conversion process is highly automated, but still requires low level editing to
complete the DNC. The Canadian Hydrographic Service (CHS) is required to provide
DNCs to the Canadian Navy with no information loss during the conversion process
[Brunt, 1999]. In an effort to further automate this process, more harmonization work
remains.

This report examines the Electronic Navigational Chart and the Digital
Nautical Chart to determine which product is best suited to fulfill the data requirements
of a purpose built submarine navigation system. Additionally, the functional
requirements needed to support submarine navigation are introduced and, the benefits
that would be achieved by automating these functions are explained. After the
comparison of data formats and statement of functional requirements, recommendations
are made on how a submarine navigation system could be developed.

1.2 Situational Awareness

Traditional methods for assessing navigation and collision avoidance
situations are based on an individual officer’s experience and ability to assimilate and
absorb information from several sources, often called situational awareness. Perhaps the
greatest asset of ECDIS is that it provides a situational assessment accurately and in real
time, thus better supporting collision avoidance and navigation decisions.

One of the first milestones in a young naval officer’s career is obtaining a
Bridge Watchkeeping certificate, a qualification granted by a Commanding Officer only
when the young officer is deemed competent to take charge of the ship by day or night.
Perhaps the single most difficult task facing a bridge watchkeeper is the running of the ship in total darkness, during a busy exercise. During coordinated anti-submarine warfare exercises, it is common for six or eight ships to be within 8000 - 10000 yards, all on different courses and at different speeds. To make matters even more complicated, there is usually a flying schedule that complements the exercise program; thus in the middle of these exercises, the ship may have to alter to a suitable course for launch or recovery of the aircraft.

Safety of the ship and her company during these exercises is the primary responsibility of the Commanding Officer and the Officer of the Watch. One difficulty many young naval officers have is that of "situational awareness". That is, the ability to look out the bridge windows at several ships and associated navigation lights (thus presenting some indication of aspect), look at the radar screen and identify which radar return is associated with which visual contact, look at the paper chart to determine own ship's position, and finally put all this data together and compile an accurate mental picture of the situation. A complete appreciation of the situation will include collision avoidance/rules of the road, flying program, station keeping, navigation (position within allocated exercise area, speed required for the next rendezvous, etc.), and tactical requirements.

Modern warships have both a bridge and operations room. The operations room is the tactical heart of a warship; sensors and weapons are controlled here to effectively "fight" the ship. The bridge team is responsible for navigation, collision avoidance, station keeping, and several other duties. Ideally, both the bridge and operations room are fully aware of each others priorities and work together in an effort to
achieve all objectives. Achievement of this aim is far more difficult than one might think, as each position has access to different equipment and data displays: a common display with all information does not exist. Communication is key!

Until very recently, the paper chart has been used as the sole representation of the mariner's nearby environment. The chart was used to plan (and execute) everything from simple ocean passages to complex pilotage and ship-handling procedures. The development of ECDIS has provided the mariner with a revolutionary new tool for navigation that can be used during the planning and execution of navigation passages. ECDIS is integrated with the *Global Positioning System* and may also be integrated with the ship's radar; this can provide a "bird's-eye-view" of the ship and surrounding area, greatly enhancing the sea-going officer's "situational awareness". An ECDIS, however, is much more than a colour display of a paper chart. ECDIS combines geographic and textual information into a tool capable of continuously determining a vessel's position in relation to land, charted objects, aids to navigation, and unseen hazards. ECDIS is a real-time navigation system that integrates and displays a wide variety of information in a format easily absorbed by the Officer of the Watch [Alexander et al., 1998]. As with all navigation aids, Bridge Watchkeeping Officers must not become reliant on ECDIS. This technology is capable of greatly enhancing the decision making process, but it is not a substitute for basic navigation and seamanship skills. If ECDIS is allowed to replace these skills, it has failed in its mission to increase safety at sea. Overconfidence in ECDIS can lead to complacency in watchkeeping, which can in turn precipitate casualties [Alexander and Bishop, n.d.].
The electronic presentation of traditional navigation information has developed rapidly in recent years. The International Maritime Organization (IMO) and the International Hydrographic Organization (IHO) have established standards for production and display of digital vector data used in an ECDIS. ECDIS as a standalone unit is a very powerful tool. However, if it were capable of displaying military information as well as, or instead of, the IHO approved Electronic Navigational Chart (ENC), ECDIS capability would be further enhanced. In an effort to maximize the capability of any electronic navigation system for use in warships, the NATO Navigation Subcommittee established an Ad Hoc working group. The working group was to define performance and functional requirements as well as the technical standards for the Warship Electronic Chart Display and Information System (WECDIS). Additionally, this working group would develop a standard for the use of additional military layers within WECDIS. These additional layers could be used to present information for a specific operation or task such as a minefield transit or the organization and implementation of a waterspace management plan.

1.3 Digital Data Standards

Two standards have emerged as “front-runners” for digital navigation within Canada: NATO’s Dlgodal GEographic Information Exchange STandard (DIGEST) and the International Hydrographic Organization’s (IHO) S-57. In the following few paragraphs, a brief historical overview of both standards is presented.

ECDIS systems are specialized Geographic Information Systems (GIS) that, in the simplest of terms, have three components: hardware, software, and data. The data component of computer mapping systems has been the weakest of the major components,
and database advances have lagged far behind hardware and software advances [Robinson, Morrison, Muehrcke, Kimerling, and Guptill, 1995]. A significant issue in the advancement of the data component is the introduction of standards. Evangelatos, in Taylor [1991], suggests that the lack of a useful digital geographic interchange standard(s) is a significant impediment to the growth of geographic information systems, and that the potential benefit of creating standards (by consensus or regulation) can be enormous.

In June 1991, the Defence Mapping Agency (DMA), on behalf of the Digital Geographic Information Working Group (DGIWG), published edition 1.0 of DIGEST. The DGIWG, an 11 nation committee drawn from military and associated civilian organizations [DON, 1992], developed DIGEST as the standard for exchange of Digital Geographic Information between member nations. Edition 2.0 was published in June 1997.

In 1983, the IHO established the Committee for the Exchange of Digital Data (CEDD) to create an exchange format for data transfer between hydrographic offices. Two years later, their mandate was expanded to include a transfer standard for the exchange and dissemination of electronic chart data [Taylor 1991]. As a result CEDD has developed IHO Special Publication 57(IHO S-57). S-57 is the IHO Transfer Standard for Digital Hydrographic Data, and includes a theoretical model, object catalogue, and data format. Version 2.0 (November 1993) was considered stable, and did not undergo major revisions prior to 1996 [Alexander 1995]. Edition 3.0 was introduced in November 1996 and will remain frozen for six years. Enforced stability is essential for
the standard to remain usable; too dynamic a standard would dissuade Hydrographic Offices from producing S-57 data.

The IHO and the North Atlantic Treaty Organization (NATO) have been working independently towards achieving data interchange standards for their different mapping requirements. The development of different standards gives NATO countries several options for the electronic navigation of warships. NATO could simply use off-the-shelf ECDIS, but this would not fully realize a true warship ECDIS. A system using only DNC data could also be implemented, but this would restrict users to data NIMA considered essential for the DNC database. The most realistic solution is the development of a Warship Electronic Chart Display and Information System that uses IHO approved data when appropriate but could augment or replace S-57 ENCs with other data forms (i.e. DNC and Additional Military Layers). Additionally, such a system would provide “paper chart capabilities” which are not resident within ECDIS.

### 1.4 WECDIS Concept

WECDIS is viewed as an extension of conventional ECDIS, permitting all aspects of navigation from planning through execution and recording. WECDIS will be able to augment chart displays with additional military layers and navigational data not normally considered necessary for safe navigation. The use of additional geospatial data transforms WECDIS from a tool for safe navigation only to [possibly] a key integrated component of a Command and Control system.

Official charts (paper or otherwise) must contain all information that the responsible government agency considers is required for safe navigation within its
waters. What makes a chart "official" is that the producing agency accepts liability for
the accuracy of the data, thus the emphasis of these "official" charts is on safety of
navigation. Often, at peace or war, operational necessities may require a warship to
proceed into poorly charted waters. Safe navigation is still critical (arguably more so),
but "official" chart data may be very dated or unavailable, thus the emphasis shifts to
"best available data" [IDON, 1998]. The need to display best available data requires
WECDIS be able to use "official" charts (normally the best available data), other data
types, and maybe some combination of data. The concept of best available data does not
mean that DNC producers have access to data procured by the best means possible, but
rather charts will be produced using the best data currently available. Thus, while an
official chart errs on the side of safety, charts based on “best available data” may not.

At the heart of WECDIS will be a commercial ECDIS that, with adequate
backup arrangements complies with the chart requirements of Regulation V/20 of the
1974 Safety of Life at Sea (SOLAS) Convention. This system will normally utilize the
Core Navigation Information (CNI), a database containing all necessary navigation
information in vector format. Additionally, the system will be integrated with both a
military GPS receiver and an Automatic Radar Plotting Aid (ARPA). ARPA reduces the
workload on radar operators by automatically detecting and tracking contacts.
Integration with the ECDIS component provides additional navigation information for
use in determining collision avoidance action that is consistent with the International
Regulations for the Prevention of Collision at Sea (the Rules) and navigationally safe.

Another requirement considered necessary for safe navigation in a military
environment is the ability to conduct pilotage navigation without CNI. Auxiliary
Navigation Information (ANI) is a WECDIS data product that contains all required information needed for safe navigation in some other format (i.e. raster). ANI will normally serve as a backup to the CNI [STANAG 4564, 1998] but may be used when CNI is unavailable.

WECDIS must also be capable of supporting navigation without GPS data, to facilitate this requirement, WECDIS must be capable of:

1. Plotting visual fixes (three or more bearings, running fixes, horizontal and vertical sextant angles);
2. Plotting radar fixes;
3. Construction of tracks based on head/stern marks;
4. Construction of clearing bearings; and
5. Sounding additional alarms consistent with new capabilities.

These additional capabilities provide redundancy by allowing "paper chart" navigation on a digital chart.

In addition to S-57 ENC, WECDIS shall be able to read several other data types including DIGEST Digital Nautical Chart (DNC) Vector Product Format. Additional Military Layers will provide mission specific data. These layers will include [STANAG 4564, 1998]:

1. Command and Control: Minefields, Exercise Areas, Ice Limits, Territorial Waters, Fishing Zones, etc.
2. Routes, Areas and Limits: Classified Exercise Areas, Waterspace Management Grids, etc.
3. Bathymetric Contour: For dived navigation, mine hunting operations, variable depth sonar / towed array employment, etc.

4. Mine Counter Measure (MCM) Contacts: Objects on the bottom that are not mines, but could be confused as mines, a baseline for mine hunting operations.

5. Wrecks and Major Bottom Objects: Bottom objects that could be confused as submarines (both by acoustic or magnetic signature).

6. Seabed Environment: sediment characteristics (weight capability, depth, acoustic qualities, vegetation etc.)

7. Anti-submarine Warfare: Deep water sediment type, suitability for bottoming, depth, underwater obstructions (pipelines), etc.

8. Oceanography: Physical properties salinity, temperature, sound velocity profile), currents, biology, fronts, eddies, ice, noise levels (shipping and ambient).
1.5 ENC / DNC

The International Hydrographic Organization and the NATO-based Digital Geographic Information Working Group (DGIWG) have both produced digital hydrographic product specifications: the IHO Electronic Navigational Chart (ENC) and the DGIWG Digital Nautical Chart (DNC). The two chart formats fulfil the digital charting requirements for their respective organizations, but are born of different mandates. The different approach to producing the two products has resulted in significant differences, thus creating areas of potential conflict. The principle of the Electronic Navigational Chart is safety of navigation, while Digital Nautical Chart focuses on best available data [IDON, 1998].

An ENC is an electronic equivalent to the "official" [paper] chart, thus they must contain all the information that the producing agency considers to be required for safe navigation within its territorial waters [IDON, 1998]. The "official" chart must meet strict content and quality standards, but because of the new digital presentation, technical facilities are also subject to an International Electrotechnical Committee (IEC) certification. IDON’s definition of the ENC may be a bit general. The definition in appendix 3 of IHO S-52 follows:

Electronic Navigational Chart (ENC) means the database, standardized as to content, structure and format, issued for use with ECDIS on the authority of government-authorized hydrographic offices. The ENC contains all the chart information necessary for safe navigation, and may contain supplementary information in addition to that contained in the paper chart (i.e. sailing directions) which may be considered safe for navigation.
To further complicate matters, the ENC product specification (Appendix B.1 to S-57) defines the ENC as the latest version of official data carried by a vessel for the intended voyage [IHO S-57, 1996]. The multiple definitions of the ENC have managed to create confusion rather than answer one simple question: what is an ENC? Ironically, the most general definition comes from the ENC product specification itself!

Alexander [1998] classifies electronic chart data based on four criteria. Classification is based on data type (vector or raster), format (for vector data types), data content and structure, and finally issuing authority. Figure 1-1 shows the classification scheme. Note only one combination of the classification criteria constitutes an electronic navigational chart.

The Digital Nautical Chart product specification defines the DNC as a vector-based digital product that portrays selected maritime physical features in a format suitable
for computerized marine navigation. More simply, the DNC is a DIGEST compatible product designed to meet the maritime requirements of NATO. DIGEST and S-57 have similar evolutions, but the scope of DIGEST is much broader. In order to develop a standard that could be used in joint operations, all data must be interchangeable; thus DIGEST can produce, and integrate, land, sea, and air digital geographic products. DIGEST is actually a suite of standards that includes a general specification as well as several defined products. DNCs are just one of these products.

ENC and DNC data sets consist of two basic parts: content and carrier. The content of either data set is based on the producing agencies interpretation of the product specification, not the S-57 or DIGEST standard [IDON 1998]. The content of either format is the hydrographic data, while the carrier is the data format. The carrier is analogous to human language, while the content would be analogous to a specific conversation.

Since both products are used for safe navigation, content should be similar within the scope of the previously mentioned mandates; just the format would be different.

Previous comparisons between ENC and DNC have concentrated on the comparison of the supporting technical standards, that is a comparison of S-57 and DIGEST. Various versions of the Interface Control Documents (Versions 1 & 2) are examples of the comparison at the standard level. The Joint Harmonization Committee of the IHO and DGIWIG produced various versions of these documents between April 1995 and September 1997 in an effort to contrast and compare the two standards and identify area of potential harmonization [IDON, 1997]. Alignment and comparison of
these standards is useful, but comparison at the product level is also required to harmonize ENC and DNC: they are product specifications that define content, not format. That is, they define a conversation rather than the language used in a conversation. IDON [1998] highlights the content/format issue by stating that, given the technical facilities, ENC can be DIGEST encoded, and DNC can be S-57 encoded. The ENC to DIGEST conversion could eventually be the method of providing official data to WECDIS, while the DNC to ENC conversion could be used to assist S-57 production.

ENC / DNC harmonization is a tremendous problem that must be addressed if a system like WECDIS is to be implemented. The different structures of the two formats complicate basic yet critical issues such as chart updates. More sophisticated issues to be resolved include the integration of DIGEST data and S-57 data, this requirement prohibits a simple “multi-fuel” approach to WECDIS. A multi-fuel approach would allow the system to use one type of chart or the other, but ideally the system should be able to use both types of data at the same time.

1.6 The Problem

The purpose of this report is to identify the requirements for developing a submarine electronic navigation system. This problem is broken down into two major areas: the identification of the functional requirements of the system, and identification of a suitable data source for such a system. Functional requirements are identified through a review of current submarine navigation techniques, while data requirements are analyzed through review of ENC and DNC at the standard, product and production level.

The creation of a submarine navigation system is beyond the scope of this paper; however, recommendations are made in support of such a system. Some of the
issues addressed have implications beyond submarine navigation, and their resolution will improve the usability of current navigation systems.

1.7 Methodology

To satisfy some of the project objectives, CARIS tools are used to create both a DNC and an ENC from the same data. The S-57 compliant ENC was produced after a training course at Universal Systems Limited using a small portion of Canadian Hydrographic Chart 4201 (the Halifax Narrows); the same data was used in the production of the DIGEST compliant DNC. These “research” phases provided valuable insight into the problems associated with chart production, and provided a practical means to gain familiarity with the two data standards. Additionally, the production process provided the author the opportunity to rigorously inspect both electronic charting formats, allowing for a better assessment of the suitability of these products in support of submarine navigation.

This report has been organized into six chapters. Chapter one has provided a brief introduction to digital navigation, and the submarine “oversight”. Chapter two describes the functional requirements for dived navigation, and why any submarine navigation system must accommodate these needs. Together, chapters three and four review the two prominent electronic chart products to help identify the product best suited for use in a submarine navigation system. Specifically, chapter three examines the ENC and the production process with CARIS tools: the DNC and DNC production are reviewed in chapter four. Specific recommendations for a Submarine Electronic Chart Display and Information System are made in chapter five, and conclusions and suggested future work are in chapter six.
Requirements for a Submarine ECDIS

2.1 Introduction

This chapter describes the unique requirements of submarine navigation and how a dedicated Submarine ECDIS (SECDIS?) could improve dived navigation and enhance operational capability. Conventional ECDISs rely on GPS/DGPS to provide continuous position information, while the WECDIS product specification goes one step further and requires that the system include additional route planning, monitoring, alarms and voyage recording capabilities [Appendix 1 to Annex A to STANAG 4564]. The additional WECDIS capabilities allow the system to take a more traditional role in the navigation of a warship by allowing the planning and execution of a voyage without the use of radio fixing aids. They also ensure that, when actual position is not displayed on the system, a dead reckoning or even an estimated position is displayed. The additional capabilities required by WECDIS still are not capable of safely supporting dived navigation.

2.2 The Pool of Errors

Once the periscope slips beneath the waves, all conventional methods for determining the submarine’s position are gone. Position can only be approximated by dead reckoning or estimated position. Some modern submarines utilise expensive inertial navigation systems, but many still rely on people accurately maintaining the vessel’s position. Either method provides only an estimation of the actual position, and errors cannot be reconciled until the next fix. As mentioned above, WECDIS will be capable of dead reckoning (DR) and providing estimated positions (EP). However, these capabilities fall short of the requirement for dived navigation.
Submarines use a “worse-case scenario” style of navigation, where they DR/EP an expanding area, and assume that the submarine is within that area (known as the “pool of errors”), that can be considered as the 100% confidence region. The pool of errors is a function of:

1. Gyro error. Gyro error will lead to off track displacement. Displacement off track will increase over time.

2. Log error. Log error will lead to along track displacement that will also increase over time. The speed error brackets the ordered speed and thus is a plus or minus error.

3. Fix error. The fix error is a constant systematic error applied to the last fix and is considered invariant over time.

4. Tidal stream error. Tidal stream error accounts for any variations between predicted currents and actual currents as well as the difference between depth of predicted currents and submarine depth. When appropriate, assumed ocean current may be substituted for tidal current.

The concept of the pool of errors is quite simple: once these errors have been accounted for there remains a shape within which the submarine must remain. Thus, when the outer boundary of the pool of errors approaches some feature that must be avoided, the submarine alters course.

Construction of a pool of errors is a relatively straightforward process. First the straight-line range and bearing from the last known fix to the DR position is calculated. Log error is applied along the bearing by the same amount either side of the
DR position. This amount is expressed as a percentage, thus a five percent log error applied to a DR based on a course of north at four knots for one hour, would be 2 cables (400 yards) either side of the DR position. Assuming log error only, we believe the submarine to be along the course steered (000), somewhere between 3.8 and 4.2 nautical miles from the last fix.

Gyro error is applied from the last known fix position to the DR position as an angular quantity. Direction of gyro error is not specified, thus a two degree gyro error applied to a course of north would include a “cone of courses” from 358 – 002. Actual gyro error is considered to be less than the error value used and affects distance off track. The combination of log error and gyro error results in a trapezoid. A constant fix error is then applied equally to all sides of the trapezoid to account for any errors in the fixing method.

Finally, the estimated effect of tidal stream / ocean current error is applied. This error is used to account for errors in tidal stream prediction and in variations of tidal stream with depth. It is applied as a percentage of the expected value in both the along track and across track direction. The tidal stream error by itself produces an ellipse, but once applied to the outside of the previously created trapezoid, a unique shape is formed. It is this shape that must be navigated clear of all dangers.
Figure 2-1 shows a typical pool of errors. It is this dynamic shaded area that must be kept clear of any danger, not just the fix/DR/EP. A pool of errors is only valid for the instant it is constructed: if used before the time for which it is valid, unnecessary restrictions may result; if used after the valid time, the submarine may stand into danger. In open ocean this is not a big concern, but when the submarine operates dived in coastal/pilotage waters, the maintenance of a pool of errors is both time consuming and critical. Currently, the pool of errors is constructed on a mylar sheet that is overlaid on the chart in use, thus presenting a static view of a dynamic entity. Development of SECDIS could ensure that a truly dynamic pool of errors is continually updated and displayed, thus presenting a more realistic view of the navigation situation. This method of navigation - while essential for safe dived navigation – is not available in ECDIS nor is it planned for WECDIS.

### 2.3 3-D Navigation

Another major difference between dived and surface navigation is the requirement to operate in three dimensions. Without discussing submarine construction constraints, there remain two other constraints that restrict the diving depth of a submarine. First, the most important constraint is the bottom; submarines often operate in waters shallower than the vessel’s deep diving depth. The second, and perhaps less
apparent constraint is the “buffer” that the submarine must keep between the vessel’s keel and the bottom. This safety zone is required so that depth excursions and control surface emergencies can be dealt with prior to touching bottom.

Consistent with the above-mentioned constraints, there is always a declared “safe depth” when the submarine is dived. This is the depth to which the submarine will proceed in an emergency in order to avoid collision with a surface vessel. When in deep water (i.e., much deeper than maximum safe depth required to avoid any surface vessel), safe depth is calculated by considering the submarine keel-to-fin-top height, an adequate safety margin, and the draught of the deepest vessel in the world. As the submarine enters shallower water, the bottom becomes an increasing concern. Once the bottom prohibits using a safe depth calculated by the above-described method, the declared safe depth must be reduced. This reduction of safe depth occurs in several steps until the submarine is restricted to periscope depth, an undesirable but not unlikely position.

The submarine navigator prepares charts for dived navigation. If there is a region on a best-scale chart (i.e. largest scale available for the area) where “deep water” safe depth can not be reached, additional colour coded contours are drawn to highlight regions of reduced safe depth. These contours are determined by applying a bottom safety margin to the charted depth (predetermined by the captain), and creating a new contour by interpolating between the existing soundings. As speed increases, the bottom safety margin must also increase so that reaction time to an emergency is not reduced. However, once inked onto a paper chart the bottom safety margin cannot be changed. Creation of dived navigation charts is tedious and time consuming as reduced safe depth contours must be pencilled in, independently checked, and finally inked on the chart.
Figure 2-2 shows a portion of a chart prepared for dived navigation showing the approach to St. Margaret’s Bay in Nova Scotia. Just in this small portion of a chart, we notice areas where the submarine cannot proceed dived (“No Go”), areas where safe depth is periscope depth (PD), 90’, 110’, and 140’. Soundings on this chart are in fathoms, but safe depth is in feet, the units of the depth gauge. With the introduction of the Upholder Class submarines, safe depth will be in metres, consistent with unit standards within S-57 and DIGEST charts.

Automated creation of safe depth contours would greatly reduce the workload of the submarine’s navigating officer, and given, a sufficiently robust contour generation algorithm, improve accuracy of safe depth contours. Additionally, if a system were capable of defining these contours “on-the-fly”, they could be tailored to height of tide or redrawn when speed changes or operational requirements necessitate a change of the bottom safety margin. Safe depth contours are critical to safe dived navigation, and this capability must exist for SECDIS to be viable.
2.4 Waterspace Management

Submarine routing is analogous to an air traffic control system. Allied submarines are required to seek approval prior to diving so there is no chance of two submarines being in the same geographic area at the same depth at the same time. Approval is normally granted well before proceeding to sea and, once written permission is received, much effort is required to ensure charts reflect the geographic and time restrictions associated with diving.

Geographic constraints on submarine operations can be broken down into three broad categories:

1. Established exercise areas;
2. Temporary areas; and
3. Transit lanes.

When operating in an established exercise area, the submarine is assigned to a predefined area for a given time period. In a temporary exercise area, both the area and time periods must be defined. While operating a transit lane, it is not practical to assign an entire lane to a single submarine, thus the submarine is assigned a “moving haven”: a box of specified dimension and speed of advance.

Additionally, there may be several depth and time restrictions associated with each of the geographical constraints. It is common for allocated waterspace to change several times within a single watch, thus the Officer of the Watch must be aware of the expiration time of the area in which the submarine is operating, the “opening time” for the next area, and so on. Waterspace management can easily “snowball” into a time consuming effort, requiring extreme vigilance to keep the submarine in authorized water.
The ability of modern computer systems to organize and display data could be exploited and combined with SECDIS, so that the navigation display includes assigned areas / lanes.

2.5 The Digital Local Operations Plot

One of the greatest challenges when operating in a dived submarine is to compile an accurate “surface picture” using only passive acoustic information (bearing, propeller RPM, etc.). An accurate solution includes bearing, range, course, and speed, from which other critical information is calculated (distance off track, closest point of approach (CPA), time to CPA, etc.). Building an accurate surface picture is a complex task requiring input from several stations. Typically three different methods are used to independently determine a contact solution, and the final accepted solution is often a synthesis of these solutions.

One solution is determined by the local operations plot (LOP), a true motion plot that uses sonar bearings to determine the target’s course and speed. The plot is simply a large piece of trace paper with a back lit bearing-range graticule. The LOP operator (usually the navigating officer) selects an appropriate scale (i.e. 1000 yards-to-the-inch), and plots time tagged bearings from the submarine’s DR/EP position at some constant interval. Using multi-point dividers and an assumed speed, various courses and ranges are estimated. The LOP is considered part of the “navigation station” but, when in use, the chart is set aside. In addition to the LOP, the operator must also maintain the pool of errors and update the navigation chart to reflect all course and speed changes. Individually, each operation is quite simple, but when combined they often amount to one of the most demanding jobs onboard. Presentation of data in a true motion plot facilitates
easy understanding, thus a quick glance at an accurate LOP can greatly assist the submarine’s captain in understanding the surrounding situation. As a paper plot, old information remains, thus providing a “historical” perspective of the situation. This perspective assists in establishing a “big picture”, providing insight into zigzag patterns, the mean line of advance (MLA) of such a pattern, and formation disposition. When this data is combined with navigational information (i.e. the chart), valuable intelligence is often gained. This is another area where a purpose built SECDIS could greatly reduce workload and stress, lead to more accurate results, and hence improve submarine operations.

2.5.1 The LOP and Visual Attacking

Even in this era of modern sonars and highly automated tracking equipment, the importance of a timely “look” from a well trained, experienced eye cannot be overstated. During a target set-up, the bearing (from periscope/gyro interface), range (by split image range finder and known target height), and angle on the bow (an estimated value) of the target is determined. When this information is plotted on the LOP, an absolute position of the target is established. Subsequent target set-ups will provide additional absolute positions of the target, now speed between the looks, overall speed, and course can determined / refined.
2.5.2 The LOP and Blind Attacking

Figure 2-3 is an example of an LOP solution for a single target. A series of plotted bearings and an assumed speed (10 knots) were used to generate the target’s course and range. The target’s track was then dead reckoned so, at minute twenty-four, we would expect the sonar bearing to intersect the target track at the generated DR. The agreement between target DR and sonar bearings provides a measure of solution quality. This simple procedure provides the basis for other LOP techniques that can be used to provide clues in determining an accurate solution.

Referring to figure 2-3 again, note that the distance between successive bearings is increasing, this is because the bearing rate of the target is increasing. Assuming there has been no speed increase (which is easily detected on sonar) this means that target range is decreasing, thus a course that provides closing geometry should be used.
Another technique used on the LOP is the “zig procedure”. This is a method of quickly determining a target’s new course after alteration. Figure 2-4 is an example of a LOP zig procedure. There was some clue to target alteration so, at minute 08, a series of concentric circles were drawn based on an assumed speed and some situation dependent time interval. Circles may be plotted at thirty-second intervals in an extremely close situation, or at as much as three-minute intervals in long range TMA. Target alteration may be detected visually, by sonar, or by a tracking solution that fails to continue tracking; any of these clues may initiate a zig procedure. Once the first bearing is plotted, there are two possible courses, additional information in the form of more bearings, a bearing rate, or a target set-up are required to confirm the new target course [CFNOS, 1993].

The graphical and computational capabilities of any ECDIS like system could be extended to produce a digital LOP. However, total automation of this important plot should be avoided. This may seem to ignore some of the capabilities of modern computer processing, but the usefulness of the LOP would be lost if total automation were used. The true strength in the LOP is that it allows an operator to try several
solutions, to play hunches, and to use experience and intuition. The operator can work on several solutions at once and as the situation unfolds, eliminate solutions that no longer make sense.

The LOP is meant to be a “manual” plot where the operator is allowed to focus on “what makes sense” rather than tweak a computer algorithm to minimize residuals. Creating a LOP module in SECDIS that utilized the display and computational abilities of modern computers, yet retained the “hands-on” nature of a manual LOP would exploit the best of both worlds.

2.6 A Future for SECDIS?

This chapter has identified the functional requirements (beyond WECDIS) that must be contained in SECDIS as:

1. generating a dynamic pool of errors;
2. creating safe depth contours in real time;
3. the organization and display of water space management data; and
4. the ability to operate as a digital Local Operations Plot.

The purpose of this chapter has been to highlight the requirements for safe dived navigation and introduce why a purpose built SECDIS is required. SECDIS is a concept that the author has developed, and there are currently no plans in Canada or NATO to create such a system.

The requirements identified above describe additional functions that must be resident in SECDIS however, these functions alone are not sufficient for development of such a system. Consideration must also be given to the data used in SECDIS. Krakiwsky et al. [1998] describe the electronic chart data as the core of any ECDIS system thus,
development of a new electronic navigation system must carefully consider the data or “fuel” that will be used. Accordingly, the next two chapters will review prominent electronic chart products so that the most appropriate data source for SECDIS can be identified. Chapter three reviews the S-57 ENC at the standard, product and production levels, while chapter four uses an identical approach to review the NIMA DNC. The aim of these two chapters is to identify which product is best suited for use in SECDIS.
The S-57 Electronic Navigational Chart

3.1 Introduction

This chapter examines the S-57 exchange standard, the Electronic Navigational Chart, and the production process of an ENC. The purpose of such an examination is to investigate whether the ENC is a suitable electronic chart for use within SECDIS. A suitable chart is one that can support the additional functionality described in chapter two, be easily updated, and be integrated with other WECDIS data sources as described in § 1.4.

3.2 Standards

Standards are documented agreements containing technical specifications or other precise criteria to be used consistently as rules, guidelines, or definitions of characteristics, to ensure that materials, products, processes and services are fit for their purpose [ISO, 1999]. The ISO [1999] goes on to explain that industry-wide standards result from consensus agreements reached by all economic players in that sector. The aim of industry-wide standardization is to facilitate trade, exchange and technology transfer through:

1. enhanced product quality and reliability at a reasonable price;
2. improved health, safety and environmental protection, and reduction of waste;
3. greater compatibility and interoperability of goods and services;
4. simplification of improved usability;
5. reduction in the number of models, and thus reduction in costs; and

6. increased distribution efficiency and ease of maintenance.

One such industry-wide standard is the IHO standard for Digital Hydrographic Data, S-57. The remainder of this chapter will explain the S-57 standard, how it is implemented within the ENC product specification, ENC production, and usability within SECDIS

### 3.3 S-57 Data Model

The data model is an abstraction of reality. IHO [1996] explains that the real world is far too complex for a complete description to be practical, therefore a simplified, highly specific, view of the real world must be used. This is achieved by modelling reality.

The S-57 model was designed to represent the hydrographic regime. Given the geospatial structure of this regime, the model defines real world entities as combinations of descriptive and spatial characteristics [IHO, 1996]. Real world entities are broken down into identifiable sets of information called objects. Objects are then described using feature objects (characteristic description) and spatial objects (geometric description).
Figure 3-1 shows the general S-57 data model, broken down into feature and spatial objects. Feature and spatial objects are further divided into object types; descriptions of these types are given in §3.3.1 - §3.3.2.

3.3.1 Feature Objects

Four types of feature objects are used to facilitate efficient exchange of descriptive data:

1. Meta Objects – a feature object that contains information about other objects. For example, the meta object M_NSYS is used to describe the buoyage system in use within a specific area.

2. Cartographic Objects – a feature object that contains information about the cartographic presentation of an object. This object type is
prohibited in the ENC product specification (S-57 Appendix B, clause 3.6).

3. **Geo Objects** – a feature object that carries a descriptive characteristic of a real world entity. The geo object BOYLAT is used to describe a lateral buoy; attributes of this geo object will be used to further describe the buoy (port or starboard, colour, etc.).

4. **Collection Objects** – a feature object that describes the relationship between other objects. There are three types of collection objects:
   
a) **Aggregation** – C_AGGR is used to describe an aggregation. An example of an aggregation would be a “buoy”. Within S-57, a buoy, its light, and its top-mark are encoded as three different objects. They can be combined by C_AGGR to represent the “complete buoy”.

b) **Association** – C_ASSO is used to describe an association between objects dependent on each other. Pais [1997] uses a buoy/wreck relationship to describe association stating that the two objects are unique, but dependent on each other. That is, if there were no wreck, there would be no requirement for a buoy.

c) **Stack** – C_STAC is used to describe the order in which objects are stacked. This object is prohibited in ENC (clause 3.9).
3.3.2 Spatial Objects

Within the S-57 standard, there are three methods of representing the spatial characteristics of a real world entity. These three methods represent the entity as vector, raster or matrix spatial objects. Currently, only the vector model is defined, and a brief description of this follows.

3.3.2.1 Vector Model

The vector model (figure 3-2) uses a 2-dimensional planar view of reality. This model allows spatial objects to take form as zero, one, or two dimensional objects implemented as nodes, edges and faces (nodes, arcs, and polygons) respectively. When required, a third dimension is expressed as an attribute of the object; for example, a depth contour is a linear feature with the value of the contour as an attribute.

![Figure 3-2 The Vector Model](image)

Figure 3-2 is a representation of the vector model, where the following relationships exist [IHO, 1996]:

1. Isolated nodes are contained in faces;

2. Faces contain isolated nodes;
3. Edges bound faces;
4. Faces are bounded by edges;
5. Connected nodes terminate edges;
6. Edges are terminated by connected nodes; and
7. Edges are adjacent to faces.

The relationships within the vector model can be used to derive four levels of topology: cartographic spaghetti, chain-node, planar graph, and full topology [IHO, 1996]. The ENC product specification has limited the vector model to chain-node topology (clause 2.3). In chain-node topology, the representation of reality is derived from a series of nodes (connected or isolated) and edges. Any point representation is coded as a node (isolated or connected), while line representations are coded as edges that start and terminate with connected nodes.
Area representations are coded as a series of connected edges that start and terminate at a common connected node. Figure 3-3 shows chain-node topology within the vector model.

![Figure 3-3 Chain-Node Topology](image)

3.3.3 The ENC Data Model

The ENC product specification specifies the parts of the generic S-57 data model that are used in ENCs, and those that are prohibited. The result of this product specification is a model that still describes objects by feature objects and spatial objects, but with some restrictions. Feature objects within the ENC product specification are limited to Meta, Geo, and Collection object types. A further restriction is imposed on collection object types, allowing only aggregation and association collection objects. Spatial objects within ENC are represented using the vector model, while data must be encoded using chain-node topology. The result of the ENC product specification is a more specific data model shown in figure 3-4.
Figure 3-4 The ENC Data Model
3.3.4 Presentation

The models described in the above sections only provide a means for factual description of the real world; they contain no information for the display or presentation of this information. The presentation of the information may vary to suit a particular case, thus it is considered independent of the storage. Applications within S-57 must provide their own presentation model, which defines the way that real world information is displayed [IHO, 1996]. The IHO [1996] continues to point out that the concept of separating information storage from presentation allows for greater flexibility.

The data within an ENC is normally presented in accordance with the Specifications for Chart Content and Display Aspects of ECDIS, IHO S-52. This publication provides the standards, specifications, and guidelines required to present electronic chart data to the mariner via the ECDIS interface. The separation of data from presentation scheme allows for the data to be used in other applications. Vachon [1999] points out that, once the digital chart database is complete, the Canadian Hydrographic Service will use digital data as a basis for paper chart production. This method of production will be a reversal of current production methods, and is easily achievable because a different (i.e. paper chart) presentation scheme does not require any change to the data itself.
3.4 Data Structure

Section 3.3 introduced the data model as an abstraction of the real world. The data model is actually the first step in a layered approach used to represent reality (Figure 3-5). This abstraction cannot be implemented into a usable format by itself, so we introduce another layer in the representation process. In this layer, the logical constructs of the model are translated into usable physical constructs (records and fields) – the data structure. This data structure cannot be directly translated from one computer system to another, so the structure is encapsulated in a physical transfer standard. Encapsulation into ISO 8211 represents the final step in the layered approach of representing reality.

IHO [1996] defines the exchange set as the set of files representing a complete, product specific data transfer. The grouping of records into files and files into exchange sets is a function of the specific product specification. However, as shown in figure 3-6, the hierarchy within an exchange set follows some general rules [IHO, 1996]:

1. an exchange set is formed of one or more files;
2. a file is formed of one or more records;
3. a record is formed of one or more fields; and
4. a field is formed of one or more subfields.

![Diagram of Exchange Set Hierarchy]

**Figure 3-6 Exchange Set Hierarchy [IHO 1996]**

The basic unit within the data standard can be considered as the record. As shown in figure 3-6, the record can be further subdivided into fields and subfields, or be grouped into files and exchange sets. The S-57 standard describes record construction, but the formatting of records into files and exchange standards is a function of the product specification. IHO [1996] describes the five categories that records fall into:

1. Data Set Descriptive (meta);
2. Catalogue;
3. Data Dictionary;
4. Feature; and
5. Spatial.

The data set descriptive records contain meta data that define defaults for the data set such as positional accuracy, horizontal and vertical datums, projection used, etc. These defaults can be superseded by information at the feature level. This would be accomplished by use of either a meta-object, or attributes within a specific object.
Within the ENC product specification, two data set descriptive records are used: the *Data Set General Information Record* and the *Data Set Geographic Reference Record*. The data set general information record contains the *Data Set Identification Field* and the *Data Set Structure Information Field*. The two fields includes subfields such as the navigation purpose (overview, general, coastal, approach, harbour, or berthing), edition number, producing agency, data structure (must be chain-node), and the numbers of various other records. The inclusion of information such as data structure might seem redundant (the product specification specifies chain-node only), but the S-57 standard requires that if a field is included in the product specification, all subfields must be accounted for. The data set geographic reference record contains the *Data Set Parameter Field*. This field contains information about vertical datum, sounding datum, compilation scale, and several other parameters.

Catalogue records contain information the data receiver needs to locate reference files within the exchange set. The IHO [1996] compares these records with a table of contents. ENC only uses the *Catalogue Directory Field*, which includes information such as file name, implementation (within ENC the data set files must be binary), latitude and longitude extremes, etc.

Data dictionary records describe objects, attributes and attribute values used in the exchange set. All non-IHO Object Catalogue objects used in the exchange set must be described in these records, but objects from the object catalogue need not be included. The ENC product specification (clause 3.2) precludes use of any non-IHO Object Catalogue objects; thus these records are not used within an ENC exchange set.
Feature records contain non-locational information of real world objects, and they contain information about record identification, object identification, attributes and pointers. ENC uses feature records to divide all objects into two groups. Group One is the Skin of the Earth and IHO [1996] explains that every area covered by M_COVR with CATCOV =1 (this means any area within the data set containing continuous coverage of spatial objects) must be totally covered by non overlapping geo objects. Group One objects are limited to:

1. DEPARE – an area of water with depth between defined values;
2. DRGARE – an area where the bottom has been deepened by dredging;
3. FLODOC – a floating dry dock;
4. HULKES – permanently moored ships;
5. LNDARE – the solid portion of the earth’s surface;
6. PONTON – a floating structure used as a landing pier or bridge support; and
7. UNSARE – an unsurveyed area.

Group Two is simply defined as all feature objects not in Group One [IHO, 1996]. Division of all objects into two groups allows S-57 to create a mosaic of objects (from the list above, note all of these objects have a geometric primitive - area) as an underlay or base display. All other information is represented in a single layer above this base. The ENC product specification provides for the several feature fields that are used to describe:

1. feature basics (group, geometric primitive, version, etc.);
2. feature identification (producer, unique feature ID);
3. feature attributes, feature-object relationships (keeps master/slave object relationships consistent between associated records); and

4. links between features and appropriate spatial information.

Vector records are used to store coordinates of feature records. The vector records within ENC are used to store information about:

1. vector identification (ID number, type, version);

2. topological relationships (beginning and ending node); and

3. coordinate information.

Figure 3-7 is a tree diagram of the ENC data structure. Structure element names are on the left, structure types are inside the graphics, and typical data within each file is listed on the right.
Exchange Set

README File

Catalogue File

Catalogue Directory

Data Set

Data Set General Information

Data Set Structure

Data Set Geographic Reference

Base Cell

Vector

Feature

Text File

Picture File

Figure 3-7 ENC Data Structure
3.5 ENC Production

3.5.1 Introduction

During this section, the production of an Electronic Navigational Chart using CARIS tools is discussed. The general procedure for production of an ENC is quite simple:

1. The paper chart is scanned;
2. The scanned image is imported into CARIS;
3. The file is prepared in CARIS for the Hydrographic Object Manager (HOM);
4. HOM automatically converts CARIS features into S-57 objects;
5. Unconverted features are manually converted;
6. Quality control tools are used to test product; and
7. The file is written to S-57.

The author produced the ENC described below during the period 17-20 February 1999, using a Dell Pentium 233 workstation. Universal Systems Limited generously loaned the author CARIS version 4.3.2 for Windows NT and the CARIS Hydrographic Object Manager version 3.0.3 for Windows NT for the project. A more detailed description of the production procedure follows. Appendix A contains some of the images produced, while the actual workflows employed are contained in Appendix B.

3.5.2 Preparing the CARIS file

A section of CHS chart 4201, Halifax Harbour and Bedford Basin was scanned as a back and white image at 600 dots per inch (dpi), and then saved using the
Tagged Image File Format (TIFF). The Map Import and Export CARIS tool was then used to import the image into a CARIS file as a raster object. When using this function, the user first sets the direction. This function can also convert from CARIS image to TIFF format, so the user must set direction to ‘From’ (from TIFF to CARIS). The source file is then selected; a new file name for the output file may be chosen (if none is chosen the output file will have the same name as the image). With the raster object in CARIS, the file could be digitized, but another tool exists that improves digitizer performance. Using the Thin 1-Bit Raster Data program within the Raster to Vector Conversion module, a new CARIS raster object with far fewer pixels is created.

Proper preparation of the CARIS file is essential if automation within the HOM is to be fully utilized. When the feature-to-object conversion is conducted, a look-up table (ih_f2o.dat file in the HOM system directory) is accessed and feature codes within the file are compared with feature codes in the table. Any feature code in both is assigned the appropriate object code as defined in the table. With this workflow in mind, the user should layer and code the CARIS file so that the maximum number of features will be converted, thus saving tedious low level editing later in the production process.

The preparation of the CARIS file is the least automated and most extensive step in the production process. The Semi-Automated Map Input (SAMI) program was used to interactively trace the CARIS raster object (the imported, thinned TIFF file) and convert the data to vector format. The first process was to create a layer (user number 1000) that contains the CARIS equivalent of “Skin of the Earth” objects. Features on this layer included neat line, shorelines and depth contours that would, once topology was built, provide complete non-overlapping coverage of the chart area (skin of the earth).
The neat line was created using the Edit→Line→Add→Point-to-Point function within SAMI. Adding the neat line in this fashion makes it easier to ensure that the file will be rectangular in latitude and longitude – an S-57 requirement for each cell. The term rectangular must be taken in context of the S-57 standard. It does not mean that the chart area is a rectangle, but rather two parallels of latitude and two meridians of longitude bound the chart. Contours and shorelines were completed using appropriate tracing functions in SAMI.

The sounding data was then added on a new layer (user number 9100). The SAMI program is capable of generating soundings by optical character recognition, but it will not properly detect decimal units. Since a harbour chart was used, most soundings were in metres and decimetres; thus they were manually entered using the Edit→Sounding→Add feature in the SAMI menu bar.

The next layer (user number 2000) contains the 2-dimensional features that would become Group Two (i.e. non-skin of the earth) objects. These are Group Two objects with an area geometric primitive. The chosen data set contained three types of these features: buildings, a bridge, and a restricted area. The function Edit→Line→Add→Point-to-Point was used to add most features on this layer as it is best suited for adding lines and straight-edged polygons. However, there were some circular buildings (storage tanks) in the data set that were digitized using the Edit→Line→Add→Circle function.

Non-navigation symbols were added to a new layer (user number 9200). This layer contains two types of non-navigation symbols, point symbols (churches, chimneys, etc.) and line symbols (overhead and submarine cables). Some of the feature codes used
for these symbols are not normally used in CARIS, thus the user is warned, and the symbol appears as a question mark. This problem will be rectified when the final product is presented using S-52 presentation rules.

The final layer of data (user number 3000) includes navigation symbols such as buoys, navigation lights, beacons, and transits. The entry of this data concluded the digitizing process. However, much work remained before the file could be passed to the HOM. The workflow used in digitizing chart data is shown in Appendix B.

The next step in file preparation was to create a control file: a set of coordinates used during registration. The coordinates in this file were in the “Non Registered in Metres” (NRMR) coordinate system; a default coordinate system used when information (horizontal datum, projection, etc.) required for another system is unavailable. With digitizing complete and a control file created, the raster data within the CARIS file can be eliminated, thus reducing file size from 2.38MB to 400KB and improving computer performance. The procedure for elimination of the raster data follows:

1. Create a scope display showing all data except the raster objects. This is done by setting the Visibility Parameter “Data Type” to raster, then removing the “include” check mark;
2. Draw an overview of the vector-only data;
3. Exit SAMI;
4. Select the Map Creation and Management module in CARIS Tools;
5. Select and run the Extract Part of a Map program (the option scope – type must be set to display).

A CARIS file consists of two components: the header file, containing the geographic referencing information, and the actual chart data. The vector file created above does not have the proper header file information, a problem corrected through registration. First, an empty CARIS file was created using the Create a Map program from the Map Creation and Management module of CARIS tools. This empty file contains correct header information for the display of the vector data. Header information for the empty CARIS file is shown in figure 3-8.

![Figure 3-8 The Header Listing](image)

The information in figure 3-8 is obtained from the user at creation, through a series of prompts, and includes ellipsoid, bounding coordinates, coordinate resolution, etc. When using Latitude, Longitude, Decimal Degrees (LLDG), there is no associated projection;
this is handled by the S-52 presentation standard at chart display. The vector file is then registered to the empty CARIS file using the Register a Map function in the Map Creation and Management section of CARIS Tools. The ENC product specification specifies the horizontal datum as WGS 84, thus our file requires a datum transformation prior to use in the HOM.

The registered vector file is without topology, which is rectified using the CARIS Editor module. The file is opened in Editor, and using visibility parameters, a scope display based on theme number is created. Topology is then built theme by theme using the following procedure:

1. **Convert Lines to Arcs** – all lines in the selected theme are converted to topological arcs;
2. **Topology→Step-by-Step Topology→Locate Arc Intersections** – all instances of arc intersection are located;
3. **Topology→Step-by-Step Topology→Cut Arcs at Intersections** – arcs are cut at intersections and new arcs formed;
4. **Topology→Step-by-Step Topology→Build Network Topology** – a network of arcs is created and errors within the network are reported.

The user must again be aware of ENC specifications while building the topology. Within an ENC, coincident line geometry (i.e., the same line in both groups) is prohibited, but the required nodes must be on both levels.
Figure 3-9 shows a restricted area (a Group Two object) bounded on one side by the shoreline (a Group One object).

![Figure 3-9 Coincident Line Geometry](image)

Since the restricted area must be constructed as a polygon in the CARIS file, the segment of shoreline is required in the restricted area’s layer. The HOM eliminates duplicate lines during the Export to S-57 process, but the user must create these “cross-layer-nodes.” These nodes are only required when a Group Two polygon uses part of a Group One polygon as a boundary, but it can still lead to some confusing cut-and-paste requirements. Additionally, the “cross-layer-nodes” will generate a pseudo-node warning when building network topology; these errors may be eliminated.

Using the Edit→Text→Add→Straight feature in CARIS editor, names were added to polygons on a layer by layer basis. These names were then converted to labels using the Topology→Step-by-Step Topology→Convert Names into Labels process, thus giving them topological significance. Polygon topology was built using the Topology→Step-by-Step Topology→Builds Polygons feature. Some applications require polygons have a unique label, so an error is listed if labels are repeated. In an ENC application the label is used so proper attributes (i.e. minimum and maximum depth in a polygon) are assigned in the conversion to objects, thus they may be repeated and this
error message (number 128) ignored. Finally, the neat line was copied to a new layer (4000) to allow inclusion of metadata in the CARIS file.

The next step in file preparation is the addition of keys, a mechanism used to relate graphic data to attribute data. The Add Keys program in the Map Data Addition module was used to automatically add system-generated keys to a user specified feature type. The program was used once for each feature type: line, polygon, sounding, and symbol.

The final remaining step in file preparation was to transform the file from the NAD 83 datum to the WGS 84 datum. Like the registration process, an empty file was created, but with WGS 84 selected as the ellipsoid (field 16 in figure 3-8). Once the empty file is created, the Transform a Map program from the Map Creation and Management module of CARIS Tools was used to perform the transformation. The file was ready for use in the Hydrographic Object Manager.
3.5.3 Adding Objects in the HOM

The Hydrographic Object Manager is a software package within the CARIS suite that is used to convert a CARIS file into an S-57, ENC compliant exchange set. Within the HOM are four windows, a menu bar and several toolbars. Figure 3-10 shows the HOM Screen Layout. Window 1 is the Control window that is used to filter the display and edit information about features or objects. Window 2 is the Graphics window, where the map is drawn and the user selects map data by a point-and-click method. Display and interaction within this window is based on filters selected in the Control window. Window 3 is the Overview window where the user can navigate the
CARIS map, and Window 4 is the Worksheet window. The worksheet window shows any selected features in the graphics window in textual format (consistent with filters selected in the Control window). The worksheet window in figure 3-10 shows that four spatial (i.e. CARIS file) objects are selected in the graphics window. The presence of a yellow triangle to the left of the text indicates the spatial object has an associated feature (S-57) object. The complete listing within the worksheet window is referred to as the selection, while a single highlighted line within the selection is referred to as the superselection.

The HOM can convert CARIS features to objects using both automated and interactive functions. The first step in the conversion process is to use the automated function Tools→Map Features to Objects. This function calls the look-up-table (LUT) ih_f2o.dat and compares feature codes on the map with the feature codes in the file. Matching feature codes are then automatically converted to S-57 objects as defined in the LUT. The user may modify the LUT, adding new mappings so that, on average a 90 to 95 percent of feature mappings are automated [USL, 1998].

The remaining editing required after use of the Features to Object program can be divided into four categories:

1. The addition of objects not converted from the CARIS file;
2. The addition of attributes to objects automatically created;
3. The addition of mandatory attributes; and
4. The addition of depth area lines.

Creation of feature (S-57) objects is accomplished by selecting the desired spatial (CARIS) object and using the Edit→Selection→Create One From Superselection
command. When several identical spatial objects are to be created, the user can select all desired spatial objects and use the Edit→Selection→Create Many From Selection command to create multiple identical objects. When either method of object creation is used, the user is presented with an interface in which object attributes can be entered.

Figure 3-11 shows the Add Attributes window for tidal stream arrows. In this case there are three mandatory attributes: category of the arrow (i.e. flood or ebb), current velocity, and orientation. The user is prohibited from creating an object with empty mandatory attribute fields.

Another editing task facing the user is the attribution of system created objects. Many of the objects created were missing optional (by S-57 standards) attributes, however failure to complete them would lead to significant information loss. The “generic” look-up-table successfully created LIGHT objects without attribution, but the paper chart displays light colour and characteristics.

Editing of feature objects is accomplished by selecting the object in feature mode, selecting the edit tab in the control window, making required changes, and applying the change.
The user must also add mandatory attributes to system created objects. In feature mode, selected objects missing mandatory attributes display a warning to the user shown in Figure 3-12. Using the editing process described above, the necessary changes are made.

![Figure 3-12 Missing Mandatory Attribute](image)

The final objects to be added are the Depth Area Lines. Depth areas are polygons that are bounded by a minimum depth contour, a maximum depth contour and some other linear feature (i.e. shorelines, chart edge, jetty). S-57 specifies that if there is a discontinuity in succession of minimum and maximum depths, the object depth area type line must be used [IHO, 1996]. Figure 3-13 depicts a jetty and surrounding depth contours and areas. To provide continuous depth successions, the line ab must be encoded as a depth area line (DEPARE type line) with minimum value 0m and maximum value 2m.

![Figure 3-13 Depth Area Lines](image)

Inclusion of this feature provides a continuous succession of depth objects and is completely automated within the HOM by use of the Tools→Generate DEPARE Lines command.
3.5.4 Quality Control

The Hydrographic Object Manager provides a series of utilities for quality control, the first of which is the *Validate HOB Contents* command. The HOB file is added to the series of CARIS files once S-57 objects are added to chart, and contains the information necessary (object and attribute data) to relate [S-57] feature objects to [CARIS] spatial objects [USL, 1998]. The Validate HOB Contents command checks that all spatial objects have an associated feature object and that object geometric primitive is compatible with the object acronym [USL, 1998]. The user selects *Tools → Quality Control → Validate HOB Contents* to run this utility.

The *Check Skin of the Earth* checks for complete, non-overlapping Group One objects, mandatory Meta-Objects, and that the cell is rectangular. This check provided an error within the sample chart that was not eliminated. The rectangular [in latitude and longitude] NAD 83 chart does not remain rectangular after transformation to WGS 84; thus a quality control error is generated during this check. A typical “work around” used by producers like the CHS is to add sliver polygons (with CATCOV = 0, i.e. no data) as necessary to ensure the final product is rectangular.

The final Quality Control check is *Filter HOB File for ENC*. This utility filters out non-ENC and non-compliant data from the HOB file as well as checking for mandatory attribution. This final check is essential as an automatic check for “second level mandatory attribution.” There are mandatory attributes for objects such as a tidal arrow object that must have an orientation attribute. It is these missing attributes that trigger a warning in the control window (figure 3-12). *Second level mandatory attribution* is how the author describes new attributes that become necessary because of
assigned attributes. An example of this would be a buoy. The user can define the colour(s) of the buoy, but once more than one colour (attribute) is assigned; the buoy must also be assigned a colour pattern (a second level mandatory attribute).

3.5.5 Write to S-57

The Hydrographic Object Manager has two wizards for preparing the data for export. The first Data Set Wizard creates the S-57 data set complete with base cell information while the Exchange Set Wizard packages previously created data set files with necessary files to create a complete exchange set (figure 3-7). The Data Set Wizard is started using the File→Export to S-57 Edition 3.0/ENC command that allows the user a number of choices:

1. Create a New Data Set – used for first time creation of an ENC;
2. Create a Update Data Set – contains only the information that has changed;
3. Create a Reissue Data Set – contains original data set plus all updates;

and

4. Create a New Edition – contains a new version of the ENC.

A reissue uses the same base data set and update numbers are not affected. This means that if a mariner’s chart were up-to-date, there would be no difference between their ENC and the reissue. However, a New Edition may contain new data and update numbers are reset.
3.6 ENC Strengths and Weakness

Electronic Navigational Charts are a tremendous leap forward for marine navigation. When combined with an ECDIS like system, they provide the mariner with real time, complete and accurate data at a single glance; information that previously required several systems, time and experience to compile. Unfortunately, the development of these standards was one of the first steps in ENC history, eliminating a period of “free” development, and thus there was a limited knowledge database from which to draw. As a result, S-57 will continue to evolve (as any standard should) but we can expect significant changes between editions. Some observations follow.

The S-57 requirement for “rectangular” charts is rather curious, and seems to be indicative of a single disciplined approach (i.e. Database Management) to standard definition, a notion supported by Monahan [1999]. A 1° by 1° section of the earth’s surface (vicinity of 40N, 60W) was transformed using the closed solution (Appendix C) from NAD 27 to WGS 84 and the “loss of rectangularity” was found to be one part in 180 thousand. Addition of slivers to ensure rectangularity seems an unnecessary step when the coverage is nearly rectangular; slack in the standard could be introduced so that small slivers need not be added, but blunders still discovered.

Another area of significant concern is the inability of ECDIS to create contours on the fly. Current ECDIS standards define the own ship's safety contour as the contour related to the own ship and selected by the mariner from contours provided for in the System Electronic Navigational Chart. This contour is to be used by the ECDIS to distinguish between the safe and unsafe water on the display, as well as for generating anti-grounding alarms [IHO, 1997]. As a result of this definition, an ECDIS is only
capable of using the object DEPCNT (depth contour) to generate safety contours. This is a rather awkward restriction since most vessels will not define their “No-Go” depth based solely on chart information, but rather on chart information as well as draught, height of tide, and some safety margin. Consider a ship with a no-go depth of 7 metres. Most harbour charts will have a 5 and 10-metre contour so, when 7 metres is selected as the safety contour, the 10-metre contour is actually highlighted. This method certainly appears to err on the side of safety, but may artificially restrict the mariner of sea room within the harbour. An even more dangerous situation could easily develop if the mariner, aware of this limitation, chose to use all the water available to him (i.e. up to the 7-metre contour) and ignore the alarms generated by crossing the 10-metre safety contour. This type of approach would maximize sea room, but could easily lead to complacency with a very serious alarm … the anti-grounding alarm! Mariners need a clearly defined contour over which, they cannot cross; current safety contours can only be defined by existing contours within the data set.

This shortcoming is partly an ENC problem, and partly an ECDIS problem. The described requirement for real-time contour generation based on factors such as height of tide, precludes producers from defining multiple DEPCNT objects (i.e. defining contours at one metre intervals) and using a combination of object suppression and display to show the desired “No-Go” contour. Real-time contour generation would require an ECDIS system to be capable of generating and displaying the contours from the sounding objects resident in the dataset, thus increased sounding density in ENCs would allow for more accurate contour creation. Given that current submarine operations are conducted with hand drawn contours on paper charts, and that a certain amount of
risk is accepted when operating dived in coastal or pilotage waters, the sounding density presented by CHS is considered sufficient for dived navigation. If this technology is extended to support emerging navigation techniques such as Under-Keel Clearance navigation, where the margin for error is significantly reduced, and the chart producer accepts liability, sounding density must be increased.

This chapter has provided an introduction to the ENC and its parent S-57 standard. Additionally, production using CARIS tools was explained, and finally some ENC deficiencies were discussed. The next chapter uses a similar format to examine the Digital Nautical Chart.
The DIGEST/VPF Digital Nautical Chart

4.1 Introduction

This chapter examines the Vector Product Format, the Digital Nautical Chart and DNC production using CARIS tools. The purpose for the review of DNC is to allow an assessment of the suitability of this product for use in SECDIS.

4.2 DIGEST and VPF

The Digital Geographic Information Working Group [1997] stated that digital geographic information has evolved into an essential element in planning and conducting both civil and military operations, and that data volume and complexity necessitate multinational agreements for digital data standards. The Digital Geographic Information Exchange Standard (DIGEST) is such an agreement. A complete discussion of DIGEST is beyond the scope of a single chapter, however elements relevant to the Digital Nautical Chart (DNC) are discussed, based on DGWIG [1997], DoD [1996] and NIMA [1997].

4.2.1 Vector Product Format

The Defense Mapping Agency (now NIMA) produces the DNC as a vector based digital product suitable for computerized marine navigation [NIMA, 1997]. DNC is implemented using the Vector Product Format (VPF), and encoded using the DIGEST Feature and Attribute Coding Catalogue (FACC).

VPF is an American interface standard that was developed from an early edition of DIGEST. The standard defines format, structure and organization for large geographic databases and introduced a new encoding technique that allowed for direct
use [McKellar, 1999]. Given the intention for direct use, VPF includes a data model as well as a structure and encapsulation standard: it is, in its own right, a complete standard independent of DIGEST. This independence from DIGEST can cause confusion, since much documentation refers to DNC as the “DIGEST electronic chart”, and also since the DNC performance specification makes only passing reference to DIGEST when discussing the FACC. The relationship between VPF and the current edition of DIGEST is that VPF was utilized as the basis for the DIGEST Vector Relational Format (VRF) standard [Staggemeier, 1998]. Staggemeier [1998], at the request of the DGIWG, investigated the differences between VPF and VRF and concluded that during VRF development, authors were able to make some clarifications, provide better explanations, and in general “clean-up” the document. Ongoing implementation issues with VPF have prevented the improvements in VRF from being “rolled-back” into VPF. The differences noted in Staggemeier [1998] all describe extended capabilities in VRF, thus we can consider VPF to be a subset of VRF. This means that a VPF compliant dataset is VRF (and hence DIGEST) compliant.
4.3 VPF Data Model

The VPF data model is broken into three sections: data organization, model components and data quality. However, before an explanation of the data model is given, an overview of DNC organization is useful. When production is complete, worldwide coverage will be achieved with only 29 DNCs (Figure 4-1). A DNC is a standalone database covering some large section of the earth’s surface; it is not analogous to a digital version of a single paper chart, but rather a chart folio (a group of paper charts covering a specific region). This “chart folio” is organized into sections called libraries where geographic information is stored. Libraries contain data based on “navigational purpose”, one library contains all coastal “charts”, another all approach “charts”, and so on. Additionally, each DNC contains a browse library that allows the user to obtain an overview of the DNC. This is roughly analogous to a chart catalogue.

4.3.1 Data Organization

Data organization examines the VPF data model on the basis of its physical constructs: directories, tables, and indexes. Directories are files that contain other files and identify their name, length and address, in a DNC; they are at the database, library and coverage level. Tables provide organizational structure for data content, using a table structure defined by VPF. They contain metadata in the form of a table header that
provide table descriptions and column definitions. Tables also contain a method of unique row identification (a primary key) and the data itself. Indexes are files associated with tables that, depending on table structure may be mandatory or optional. Indexes contain references to variable length data entries (coordinate data or text strings) as well as spatial and thematic data; their use allows for improved data access and retrieval during query operations.

4.3.2 Data Model Components

Figure 4-2 shows the VPF data model as four distinct layers. The lowest level, the feature class, is composed of VPF primitives and attribute tables. The feature classes make up sets of features with interconnecting topology and specified spatial extent known as coverages. Groups of coverages sharing a specified spatial extent and coordinate system form a library, and groups of libraries, as defined by a product specification, form a database.

4.3.2.1 Feature Class

Three geometric primitives (node, edge and face) and one cartographic primitive (text) are combined to model geographic phenomena using vector geometry. Any real world entity that has been modelled is called a feature and features that share a common set of attributes are called a feature class. VPF has two types of feature classes:
**simple feature type** and **complex feature type**. A simple feature consists of a single primitive table and a single simple feature table; simple features can be:

1. Point feature class (i.e. a buoy);
2. Line feature class (i.e. a depth contour);
3. Area feature class (i.e. a restricted area); and
4. Text feature class (i.e. a single label).

A complex feature class consists of some combination of simple and / or complex feature classes with a single complex feature table. An example of a complex feature is an airport where areas are used to define buildings and runways, and points identify lights; when combined together, they describe a single complex feature - the airport. Figure 4-3 shows how a complex feature could be created from a series of simple features.

![Figure 4-3 Feature Structural Schema](image)

In this instance, a single complex feature table is at the top of the diagram, while the combination of simple features (recall, this means simple feature table and primitive table) are in the next two rows. Together, they form a complex feature.
4.3.2.2 Coverages

Coverages have three mandatory components: primitive files, feature tables, and feature class schema. Primitive files contain coordinate and topological information, feature tables contain the descriptive information, and feature class tables contain information on feature classes allowed in the coverage.

VPF accommodates four levels of topology. The level of topology is specified in individual product specifications. Thus, various product specifications define the level of detail and constraint in topological relations according to complexity, completeness and consistency of the data. The four levels are:

1. Spaghetti data (level 0) does not describe any topological relationships between primitive entities and only represents line and point features. Area features may be deduced when lines circumscribe an area.
2. Chain Node data (level 1) defines edge node topological relationships and is sufficient to describe connectivity (same as ENC).
3. Planar Graph data (level 2) introduces the additional constraint that edges can only cross at a node. Addition of this constraint allows for calculation of adjacency.
4. Full topology (level 3) introduces the concept of faces (polygons) and contains information about adjacency, left face / right face, node-in-face and all information from lower levels of topology.

DNC uses level 3 topology on all levels except the Library Reference and Relief coverages where level two topology is used; there is no topology between coverages.

DNC divides coverages into tiles for purposes of data management; tile size is a function
of the parent library's navigational purpose and is listed in table 4-1. A single value is sufficient to represent tile size; all sides are the same “length”, using degrees/minutes of latitude and longitude, as appropriate.

<table>
<thead>
<tr>
<th>Library</th>
<th>Tile Size</th>
<th>Chart Scales</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td>3°</td>
<td>&lt; 1:500,000</td>
</tr>
<tr>
<td>Coastal</td>
<td>3°</td>
<td>1:75,000 → 1:500,000</td>
</tr>
<tr>
<td>Approach</td>
<td>30°</td>
<td>1:25,000 → 1:100,000</td>
</tr>
<tr>
<td>Harbour</td>
<td>15°</td>
<td>&gt; 1:50,000</td>
</tr>
</tbody>
</table>

4.3.2.3 Libraries and Databases

DoD [1996] defines a library as a collection of coverages that share a single coordinate system and scale, have a common thematic definition, and are contained within a specified spatial extent. Coverages contained in the libraries are defined by the product specification, in DNC the coverages are: Cultural Landmarks, Earth Cover, Environment, Hydrography, Inland Waterways, Land Cover, Limits, Aids to Navigation, Obstructions, Port Facilities, Relief, and Data Quality. Each DNC contains a browse library for orienting the user and four types of “navigational purpose” libraries: General, Coastal, Approach, and Harbour (in order of increasing scale). Finally, a complete collection of related libraries and associated tables forms a database.

4.3.3 Data Quality

Data quality information is used so that exchanged geo-data can be verified (features, attributes, geometry) and included into a receiving database without ambiguity. Data descriptors are associated with various levels within the data structure, and use a “as deep as necessary, but as high as possible” philosophy. When data quality information exists at a given level, it applies to all data below that level, but when the information
exists on several levels, the information at the lowest level takes precedence. VPF allows data quality information for: source, positional accuracy, attribute accuracy, date status, logical consistency, feature completeness, and attribute completeness.

4.4 Implementation

The Vector Product Format is implemented through a complex series of interrelated tables that form a relational database. Conceptual explanations of the tables and their relationships as well as supporting examples (Appendix D) are considered sufficient to describe the mechanics of VPF implementation.

4.4.1 Primitive Implementation

VPF has three geographic primitives (node edge and face) as well as one cartographic primitive (text). These four primitives and associated feature tables are sufficient for modelling geographic information using vector geometry.

There are two types of node primitives, entity nodes and connected nodes. Entity nodes are “free-floating” nodes that are used to represent the geometric information associated with a point feature; while connected nodes are used to represent the start point and end points of lines. Separate tables are used for entity node data and connected node data, but the same table structure is used to maintain identical format for both node entities. The tables contain node identifiers, pointers to the associated feature, containing face (isolated nodes/level 3 topology only), containing edge (connected nodes/level 1-3 topology), and the node coordinates. Table D-1 shows structure and content of node primitive tables.
In order to support the level three topology required in DNC, the edge primitive table (D-2) has nine columns. The table includes pointers to the connected node table, but also contains the coordinates of the start and end nodes of the edge, a redundancy that aids in drawing edges, and identifying topological relationships.

Faces are defined by a derived construct – the ring. Rings are connected sets of edges that compose a face border, a face may only have one outside ring, but may have several inside rings. The face table (D-3) contains only three columns, and has a mandatory pointer to an associated ring table (D-4). Every ring in a ring table contains a single pointer to an edge table, where stored topology can be used to define the remainder of the ring. A single ring table may contain rings associated with several faces, thus the first ring with a new FACE_ID (one of the required columns) is considered to be the outer ring.

Text is used to represent names associated with geographic entities. The text primitive table contains data on the text to be displayed as well as the SHAPE_LINE, a string of coordinates defining the orientation and “shape” of the text. The final table at the primitive level contains minimum bounding rectangle (MBR) records. Predetermination of this data allows for rapid retrieval of a primitive’s spatial extent, reducing processing time for spatial queries.

4.4.2 Feature Class Implementation

Feature classes are composed of several tables containing geometric, topologic and attribute data. A single feature table (D-5) and a single primitive table (previous section) may define them, or they may require a complex hierarchy of many tables. Feature tables contain a feature identifier, tile identifier, primitive identifier,
attribute description and optionally a from_to identifier that defines feature orientation with respect to primitive orientation. Another type of table at the feature level is the feature join table (D-6), used to implement one-to-many and many-to-many relationships. The join table reduces a complex series of one-to-one relationships or many-to-many relationships into a series of simple one-to-many relationships, thus allowing the required relational joins to be constructed. Format for the join table is defined in the Feature Class Schema table.

4.4.3 Coverage Implementation

Each coverage has a “set” of topological primitive tables (one isolated node table, one connected node table, etc.) and some feature tables, the number of which is dependant upon defined topological entities within the primitive tables. These tables are the ones discussed in § 4.4.1 and § 4.4.2, thus from a data structure perspective we realize that tables describing topological entities and features are stored in a directory at the coverage level.

The mechanism used to define allowable features within a coverage and the relationships between them is the Feature Class Schema table. This table (D-7) contains information to identify a feature class, pointers to the tables in a relationship, as well as pointers to the specific columns in each related table. Another table at the coverage level is the Value Description Table (D-8), which is only required when coded attributes are used. Two types of Value Description Table (VDT) exist, one for describing integer attributes and the other for describing text attributes; if required in a coverage, only a single VDT of each type is used. Every unique coded value for a single attribute must be included in this table. A Feature Class Attribute Table describes feature class and type
(point, line, area) within each coverage and is required by the DNC product specification. This table improves performance when many feature tables refer to a single primitive table.

4.4.4 Library Implementation

The library's function in VPF/DNC is to organize collections of coverages of similar navigational purpose; they must contain at least three tables and may contain up to ten. The Library Header Table contains general information about the library including name, a description, topology level (highest level in library), scale, source, security classification, downgrading information, and releasability. Geographic parameters such as ellipsoid (name and parameters) and datums used (vertical, sounding) are stored in the Geographic Reference Table, while information on coverages within the library such as name, description, and topological level is found in the Coverage Attribute Table.

Libraries containing tiled data use the Tile Reference Coverage to identify tiles. This coverage uses the Tile Reference Area Feature Table to define tile ID, Name and the associated faces. DNC uses an additional coverage, the Library Reference Coverage, to provide a small-scale representation of the library for reference purposes. This coverage uses a single table, the Library Reference Line Feature table, to point to entries in the edge primitive table that define the small-scale reference chart.

4.4.5 Database Implementation

Information pertaining to the entire data collection is stored at the database level, in DNC this information is stored in the Library Attribute Table and the Database
Header Table. The Library Attribute Table contains the name and bounding coordinates of each library in the database, while the Database Header Table Definition table contains identification, production, and security information.

4.4.6 Overview

With all tables defined, an overview of how VPF is implemented is now possible. The smallest "bits" of information in VPF are primitives that are stored in point, edge, area, or text primitive tables. Properly attributed primitives are combined to create features, stored in area, line, point, and text feature tables. Primitive and feature tables are stored in directories at the coverage level, and the coverage level uses three types of tables to organize and control these lower level tables. The Feature Class Schema Table identifies features allowed within a coverage and defines feature relationships at the coverage level. The Feature Class Attribute Table is used to describe feature characteristics and type, while the Value Description Table (Integer or Text) is used to define all allowable values for coded attributes.
The Library organizes and controls several coverages by use of three types of tables. The Library Header Table contains general information, the Geographic Reference Table contains geographic parameter data and the Coverage Attribute Table provides information on coverages in the library. Finally, the Database must organize the contained Libraries. A Database Header Table provides general information for the entire database, while the Library Attribute Table contains library names and extent.

Figure 4-4 shows VPF implementation.
4.5 DNC Production

4.5.1 Introduction

This section discusses the production of a Digital Nautical Chart using CARIS GIS and DIGEST Object Manager (DOM) software. The same section of CA 4201 (Bedford Basin) is used and the overall procedure is similar:

1. The scanned image is imported into CARIS;
2. The file is prepared in CARIS for the DIGEST Object Manager (DOM);
3. DOM automatically converts CARIS features into DNC features (from the FACC);
4. Unconverted features are manually converted;
5. Quality control tools are used to test product; and
6. The file is written to DNC.

The author produced the DNC described below during the period 14-18 March 1999, using a Dell Pentium 233 workstation. Universal Systems Limited generously loaned the author CARIS version 4.3.2 for Windows NT and the CARIS DIGEST Object Manager version 3.0.2 for Windows NT for the project. A more detailed description of the production procedure follows; actual workflows used are included in Appendix B.

4.5.2 Preparing the CARIS file

The first steps in the DNC production process (scanning, importing raster data, and thinning raster data) are identical to those mentioned in §3.5.2. Again, this
phase of production is the most extensive and tedious. However, extra effort now will reward the user with far fewer problems in DIGEST Object Manager (DOM) at a subsequent stage. DNC has a total of twelve coverages (layers) with the allowable features of each layer defined by the DNC performance specification. Layering in the CARIS file must mirror the DNC coverages exactly; thus the user must have a well-defined layering schema (table 4-2).

Table 4-2 Layering Schema for the author’s DNC Production

<table>
<thead>
<tr>
<th>CARIS Layer</th>
<th>Coverage</th>
<th>Feature</th>
<th>CARIS FC</th>
<th>FACC FC</th>
</tr>
</thead>
<tbody>
<tr>
<td>1000</td>
<td>Earth Cover</td>
<td>Shoreline</td>
<td>CLIK</td>
<td>BA010</td>
</tr>
<tr>
<td>1000</td>
<td>Earth Cover</td>
<td>Ground Surface Element</td>
<td>LNDRGN</td>
<td>DA010</td>
</tr>
<tr>
<td>1000</td>
<td>Earth Cover</td>
<td>Island</td>
<td>CLIS</td>
<td>BA030</td>
</tr>
<tr>
<td>1000</td>
<td>Earth Cover</td>
<td>Water</td>
<td>10000M</td>
<td>BA040</td>
</tr>
<tr>
<td>2000</td>
<td>Hydrographic</td>
<td>Sounding</td>
<td>SGSL</td>
<td>BE020</td>
</tr>
<tr>
<td>2000</td>
<td>Hydrographic</td>
<td>Depth Contours</td>
<td>CODTIX</td>
<td>BE010</td>
</tr>
<tr>
<td>2000</td>
<td>Hydrographic</td>
<td>Depth Areas</td>
<td>xxxM</td>
<td>BE010</td>
</tr>
<tr>
<td>3000</td>
<td>Cultural</td>
<td>Power Lines</td>
<td>ALPWSP</td>
<td>AT030</td>
</tr>
<tr>
<td>3000</td>
<td>Cultural</td>
<td>Pylon</td>
<td>ALTW12TW</td>
<td>AR040</td>
</tr>
<tr>
<td>3000</td>
<td>Cultural</td>
<td>Buildings</td>
<td>ALBD</td>
<td>AL015</td>
</tr>
<tr>
<td>3000</td>
<td>Cultural</td>
<td>Churches</td>
<td>ALBD</td>
<td>AL015</td>
</tr>
<tr>
<td>3000</td>
<td>Cultural</td>
<td>Chimney</td>
<td>ALTWST</td>
<td>AF010</td>
</tr>
<tr>
<td>3000</td>
<td>Cultural</td>
<td>Crane</td>
<td>ALCN</td>
<td>AF040</td>
</tr>
<tr>
<td>4000</td>
<td>Aids to Navigation</td>
<td>Buoys</td>
<td>NABYBS31</td>
<td>BC020</td>
</tr>
<tr>
<td>4000</td>
<td>Aids to Navigation</td>
<td>Lights</td>
<td>NALTTLT</td>
<td>BC040</td>
</tr>
<tr>
<td>4000</td>
<td>Aids to Navigation</td>
<td>Beacons</td>
<td>NABNBN</td>
<td>BC010</td>
</tr>
<tr>
<td>4000</td>
<td>Aids to Navigation</td>
<td>Navigation Line</td>
<td>NALTROL</td>
<td>BC100</td>
</tr>
<tr>
<td>5000</td>
<td>Limits</td>
<td>Restricted Area</td>
<td>RESARE</td>
<td>FC036</td>
</tr>
<tr>
<td>6000</td>
<td>Obstructions</td>
<td>Bridge</td>
<td>BRIDGE</td>
<td>AQ040</td>
</tr>
<tr>
<td>6000</td>
<td>Obstructions</td>
<td>Underwater Cable</td>
<td>NPCA</td>
<td>AT005</td>
</tr>
<tr>
<td>7000</td>
<td>Port Facilities</td>
<td>Calling in Point</td>
<td>NPCIDB</td>
<td>BB050</td>
</tr>
</tbody>
</table>

Table 4-2 provides a layer to coverage mapping, textual feature description, as well as the CARIS and FACC feature codes.

The CARIS file is prepared in the following basic steps:

1. Digitize data using layering schema (table 4-2);
2. Register the file;
3. Extract new files, creating maps containing only a single coverage; and

4. Build topology on each new file.

The first process was to add features that would become part of the Earth Cover Coverage, a layer that includes topographic and hydrographic features of significance to navigation (land, water, shorelines, boundaries, etc.). These features were added to CARIS user number 1000. The neat line was created using the Edit→Line→Add→Point-to-Point function of the Semi-Automated Map Input (SAMI) module. The neat line will not become a DNC feature, but is required to provide an outer edge for several polygons that will be built. It is also added to all layers to prevent “infinite polygons” [USL, 1997]. Shorelines were then added using the Vectorize Lines program in the SAMI module.

The next step was to add features to user number 2000, a layer that would become part of the Hydrography Coverage. This coverage contains soundings, depth contours, and bottom characteristics. Soundings were manually added using the Edit→Sounding→Add feature in SAMI; the optical character recognition feature was not used for reasons stated in § 3.5.2. Depth contours were added using the Vectorize Contours program, and finally features from the previous layer required for complete polygons were pasted to this layer. These features include the shoreline, required to complete the depth area polygons from 0-2 metres, and sections of the neat line that would become edges of other depth area polygons.

CARIS user number 3000 was used for features that would become the Cultural Coverage, a layer containing information about man-made structures of
significance to navigation (buildings, overhead powerlines, etc.). The Edit→Line→Add→Point-to-Point feature was used to digitize buildings and powerlines. Point symbols such as churches, cranes, chimneys and towers were added using the Edit→Symbol→Add feature. The same procedure was used to add symbols for buoys, beacons, and lights to user number 4000, the Aids to Navigation Coverage, while a leading line was added using the point-to-point mechanism. The same procedures were used to add data to the remaining layers: Limits (a restricted area), Obstructions (a bridge and underwater cables), and Port Facilities (a radio calling-in-point).

With all the data digitized, a control file was creating using the neat line corners, generating coordinates in the NRMR coordinate system. The raster data in the file was eliminated using a scope display and the Extract Part of a Map program in the Map Creation and Management Module; reducing file size form 2.64MB to 596KB and greatly improving refresh rates. An empty CARIS file was created using the Create a Map program from the Map Creation and Management Module (Figure 3-8), and the file containing digitized data was registered to this empty file using the Register a Map function in the Map Creation and Management section of CARIS Tools.

The Extract Part of a Map program was used to extract each layer into an independent CARIS file. The Step-by-Step Topology tools were used to build topology for each file, and once the files were topologically correct, they were ready for the DOM.

4.5.3 Adding Objects in the DOM

The DIGEST Object Manager is used to convert a CARIS coded file into a DIGEST coded file (using the FACC). After quality control the file is exported to a “DIGEST Vector Product Format” database (Note: the term “DIGEST Vector Product
"Format" used in USL [1998] should read either DIGEST Vector Relational Format, or NIMA Vector Product Format, reinforcing the confusion over the DNC/ DIGEST relationship mentioned in §4.2.1). The screen layout is identical to the Hydrographic Object Manager (Figure 3-10), and operation is very similar except that DNCs are produced coverage by coverage. A topologically correct, single layer CARIS file containing only features from a single coverage is loaded into the DOM. The automated Tools→Map Features to Objects function is used and valid features that were not automatically converted (features not listed in the look-up-table ih_f2o.dat) are manually converted using the same procedure described in §3.5.3. After feature attribution has been verified the file is ready for quality control checks.

4.5.4 Quality Control

DIGEST Object Manager provides three quality checks. The first check uses the Tools→Quality Control→Validate HOB Contents function. This function verifies that all CARIS spatial objects have an associated DNC (FACC) feature, and that feature-to-primitive relationships are acceptable. The List HOB Contents function provides a listing of the .hob file and all assigned attributes, the user must then browse the output and manually check for inconsistencies. The final tool, Generate HOB Statistics, reports information about numbers of features, this report is useful for comparison if another source of information about the dataset is available.

4.5.5 Data Export

Once the CARIS file includes all necessary DNC codes and attributes, it must be translated into a VPF database, a procedure started with the File→Export to DIGEST
command. This command starts the Export to DIGEST Wizard, and asks the user to specify whether a new database is being created or the data is to be added to an existing database. If creating a new database, the user must provide the wizard with:

1. Database Type (DNC or Vmap);
2. Template (General, Coastal, Approach, Harbour, or Browse);
3. Location of the database;
4. Database name;
5. Library Name, and if the library is tiled; and
6. Tile name.

All names follow the naming convention specified in the DNC performance specification, thus the database name is of the format DNCxx, where xx is the DNC disc number (Figure 4-1). Libraries use the first letter of their category (G, C, A, H), followed by the disc number. Additionally, Approach and Harbour libraries have the World Port Index identification number for the largest port in the library appended to the title. Tiles are named using a world wide grid system that uniquely identifies each tile based on location and parent library (table 4-1), and can be automatically calculated using the Export Wizard. Once information about theme number/coverage mapping is entered (i.e. what theme number is associated with what coverage), the Export Wizard produces a complete VPF database.

The steps mentioned above create a complete, but nearly empty database since only a single coverage was exported. When the remaining coverages are exported, the Add to an existing database option is selected. This export method prompts the user for
database location, library name, and tile name, and then exports the data to the previously created database. Figure 4-5 shows the file structure of a typical DNC database.

![Figure 4-5 DNC File Structure [NIMA, 1999]](image)

### 4.6 DNC Strengths and Weaknesses

The Digital Nautical Chart, when implemented, will be a vast improvement on conventional navigation techniques. Additionally, the use of the Vector Product Format ensures a common structure with several other products (VMap, Littoral Warfare Data, etc.), thus allowing integrated display of these products. Integration of several different “purpose built” products will be an invaluable planning tool for joint operations (i.e. landing marines).

The relational database schema used in the VPF structure provides efficient, direct use electronic charts. However, this relational structure leads to what is perhaps the biggest challenge in DNC implementation, the development of an effective update mechanism. While similar products like ENC are able to update by replacing only the effected objects, DNC must, as a minimum, replace the changed feature and all
associated pointers in all appropriate tables. This approach to updating a relational database, can easily lead to data corruption, thus NIMA has adopted a different approach. O’Brien [1998] describes the use of a [complete] replacement of every table effected by the change, an approach that leads to large update files. Transmission of such large update files to deployed units requires use of sophisticated satellite communication systems that are not readily available to all allied nations. To alleviate this potential problem, any system used to display DNC should be capable of creating and displaying a corrections overlay. Use of such an overlay is described for WECDIS, a display system designed by NATO for use with DNC [STANAG 4564, 1998].

VPF contains its own presentation schema for all products and currently no capability exists or is planned to provide a contour drawing capability [Harmon, 1999]. This limitation is described in detail at §3.6 and for the same reasons should be resolved for DNC to be used in SECDIS.

This chapter has provided a detailed review of the Digital Nautical Chart, its parent Vector Product Format Standard, and provided a description of production techniques using CARIS tools. The next chapter will combine the work of the previous three chapters to define the functional and data requirements of SECDIS.
SECDIS: The Way Ahead

5.1 General Requirements

This chapter describes specific SECDIS requirements derived from the information in previous chapters. Since submarines must participate in many of the events that WECDIS and its Additional Military Layers are designed to accommodate, the author believes that any viable SECDIS system should be an extension of WECDIS, and the capabilities described in STANAG 4564 (WECDIS Concept of Operations) must be retained. SECDIS requirements are discussed below, while a possible product specification is enclosed as Appendix E.

5.2 The Pool of Errors

The ability to generate and display a pool of errors is essential for any SECDIS if digital submarine navigation is to retain current "paper" safety levels. The pool of errors generated by SECDIS must be continually updated and derived from manually and automatically inputted parameters. An outline of specific requirements to accommodate pool of error generation follows.

SECDIS should be capable of generating a pool of errors from automatic (i.e. course and speed) and manual parameter entry, however all automatic entries must have a manual backup in case of equipment malfunction. The tidal stream component of the pool of errors is used to account for tidal and current influences. When used to account for currents, the value used can be considered invariant over the time interval between fixes, but when using tidal stream data (i.e. operating inshore) fluctuations occur in a predictable manner. To accommodate these predictable and time varying fluctuations,
SECDIS should use a tidal stream model to interpolate between predicted values (entered from tide tables). The interpolated values can then be used for both pool of errors construction and generation of the estimated position (EP).

To best exploit the electronic chart database and the power of computerized navigation, the pool of errors should interact with chart data. This interaction could be used to sound alarms when waterspace boundaries are crossed, depth changes are required, or for several other reasons; a capability that would not be possible if the pool of errors were merely an overlay. The pool of errors is an essential element in dived navigation. However, it is not required when operating on the surface, thus the pool of errors capability must be able to be “turned off” for surfaced navigation.

5.3 Safe Depth Contours

Generation of safe depth contours is also an essential element of any viable SECDIS. While technical aspects of this problem are not difficult, it requires a shift in thinking if producers are to “allow” the end user to redefine chart contours. Ideally, both system producers and data producers would be involved in creation of this capability. System producers would be required to create software capable of generating, displaying and interacting with any of these contours: data producers would provide charts with greater sounding density allowing for more accurate contour generation.

Any system capable of generating contours must have a “sensitivity” function to prevent every sounding from becoming a polygon, but at the other extreme polygons should not become excessively distorted to incorporate a single outlying sounding. Once polygons are created, membership should be verified so that every sounding in the
polygon is greater (deeper) than the value of the minimum bounding contour (note: soundings may be deeper than the maximum bounding contour).

Contour generation “on-the-fly” is a highly desirable capability as this ability would allow SECDIS to change contours based on height of tide and changing bottom safety margins. This capability is also required for ECDIS to be a usable tool in Under-Keel-Clearance navigation. Ideally, an “on-the-fly” capability would allow the user to define the desired bottom safety margin or desired speed; if speed were selected contours would be generated using current speed-bottom safety margin doctrine. Generated contours must be capable of interacting with the generated pool of errors, thus providing appropriate warnings when action is required; additionally a prominent display of current safe depth should exist. The user should be able to turn off this capability to eliminate “chart clutter” while operating on the surface.

5.4 Water Space Management Requirements

In this section, SECDIS capabilities needed to support the water space management (WSM) requirements of dived navigation are discussed. Recall from §2.4, there are three areas where a submarine can expect to operate; established exercise areas, temporary exercise areas, and transit lanes. Recommendations to facilitate operating in any of these areas follow.

Once an operator selects an area where the submarine will operate dived, a buffer zone (a redundant safety measure), associated depth restrictions, and time limits must also be defined. When operating in allocated areas, boundaries should be prominently displayed; the next available area’s boundary should also be highlighted in a different colour. This combination of features will provide an accurate display of all
water space constraints (geographic, time, depth) in an easily understandable display. Functionality could be further enhanced if speed-time-distance requirements associated with WSM were also incorporated. Allowing SECDIS to calculate time remaining in the currently assigned area(s) as well as course and speed requirements for the next available area(s) would ease the workload on the control room team and serve as a constant reminder of WSM considerations.

While permanently established exercise areas are defined on existing charts (ENC object MIPARE, DNC Feature FC 301); SECDIS must be capable of creating temporary areas and transit lanes. An additional requirement when operating in a transit lane is that SECDIS must be capable of generating and displaying the moving haven (a box of defined size and speed that the submarine must remain in). Again, the pool of errors must interact with any system generated WSM objects/features.

5.5 LOP Requirements

Currently, the Local Operations Plot is a piece of trace paper that resides beneath the chart. When required, the chart is set aside and the plot table activated. This means that a back lit bearing and range graticule (receiving course and speed information) is turned on, an appropriate scale selected, and plotting and computational work carried out. This is another area where the computational and graphical capabilities of modern computer systems could be exploited to create SECDIS.

Like its paper counter part, the digital LOP should be used when the chart has been “set aside”, that is SECDIS should suppress (but continue to calculate) navigational information when operating in LOP mode. This capability would prevent displays from becoming overly cluttered and present a display containing only contact information. In
order to maintain awareness of navigation information, the operator must be able to cycle between the LOP view and the navigation view. Finally a combined view of both navigation and LOP information would be useful in determining navigation information about tracked contacts (i.e. what port is the vessel heading to/coming from, traffic patterns, etc). These patterns provide potentially valuable intelligence information, thus it is normal practice to save all LOPs for post analysis; a “save” capability must exist for SECDIS LOPs. Another method of creating a LOP “independent” of the navigation display, would be to configure SECDIS software to drive separate monitors. This method would allow both navigation and LOP information to be prominently displayed, and a simple overlay procedure could be used to form a combined display. While this may be the more desirable option, space requirements may necessitate a single display.

The digital LOP component of SECDIS must retain all capabilities of the paper LOP in order to be an acceptable replacement. Thus it must be capable of blind attacking, visual attacking, and zig procedures. A complete description of requirements necessary to support these capabilities is at Appendix E.

5.6 Data Suitability

Now that the functional requirements of SECDIS have been described, the most suitable electronic chart product must be identified. Both the Electronic Navigational Chart and the Digital Nautical Chart could be used in SECDIS however, each have different strengths and weaknesses.
5.6.1 The Electronic Navigational Chart

The ENC is a purpose built product that, from the outset, considered the chart update problem. This initial foresight lead to an object-oriented structure that allows updating by replacement of only affected objects, leading to small update files. ENC update can be done via the Internet, a capability easily extended to sea-going units, unfortunately operational requirements may preclude submarines from using this technology. The WECDIS requirement of a corrections overlay produced from text only correction messages would likely have to be employed, even with ENC data.

The ENC is capable of supporting many of the functional requirements of SECDIS. That is, the chart objects that the new functions must interact with (exercise area boundaries, depth contours, soundings) already exist in the S-57 object catalogue. Interaction with SECDIS produced objects such as temporary exercise areas and system generated contours will be a requirement of the system itself, the ENC need only provide the required data. Given that sounding information on the final chart is a conservative estimate of the field sheet and that the source paper charts have been used for dived navigation for many years, the ENC is considered to provide adequate data for use within SECDIS. However, if the producing agencies of these chart products wish to provide charts suitable for use in other applications where real time contour generation is required (Under Keel Clearance navigation), consideration should be given to increasing sounding density.

The final area of consideration is the ability to integrate ENC with other data sources. This capability currently does not exist, but is proposed for WECDIS by using an Open Systems Interconnection architecture [Alexander et al., 1998.]. Use of ENC in
SECDIS would, given current technology, limit the system to a navigation tool only. As technology improves and the WECDIS system is developed, multi-fuel integration capability may exist.

5.6.2 The Digital Nautical Chart

The relational database scheme of the Digital Nautical Chart leads to the complex update problem described in § 4.6. The WECDIS approach to providing a corrections overlay seems to provide an acceptable “work-around” to this problem as it allows deployed units to correct charts using a text only message system. Once a submarine returns to harbour, the corrections layer can be cleared, and all corrections applied in the “normal” fashion.

DNC has all the necessary features required to support the additional functional requirements of SECDIS and, like the ENC, increased sounding density would improve accuracy of SECDIS generated contours. The main advantage of DNC is that it is one of several Vector Product Format products that can be integrated to combine marine, land, and aeronautical information. This capability is a valuable tool for joint and reconnaissance operations, both typical submarine assignments.

One final and less obvious advantage of the DNC is that it is a military product with few end-users and, it has enjoyed Canadian contribution from the outset. This fact may provide Canada and SECDIS additional leverage in obtaining any future changes to the standard that could improve the product’s suitability for SECDIS.

Any SECDIS system that would be developed within Canada would be a small-scale project. The additional costs required in developing an open architecture system that would allow use of ENC might prevent SECDIS development. Given the
DNC integration capability, a relatively simple “fix” for the update problem, and the Canadian Navy’s commitment to this product, the Digital Nautical Chart is the product that should be used in SECDIS.
Conclusions and Future Work

The combination of chart and computer will revolutionize submarine navigation. Automated plotting on an electronic chart will eliminate human error, reduce workload, and improve accuracy of the submarine’s estimated position. All of these factors will allow the Officer of the Watch to focus more attention to the tactical environment thus, improving the operational effectiveness of the submarine.

The additional capabilities that must reside in the Submarine Electronic Chart Display and Information System are:

1. real time Pool of Errors generation;
2. “on-the-fly” contour generation for several safe depths;
3. the ability to enter, display and organize water space management data; and
4. the ability to operate as a digital Local Operations Plot.

These capabilities are viewed as the minimum added functions that must be incorporated to facilitate safe dived navigation.

The Digital Nautical Chart is a VPF product that can be integrated with several other products for use in joint operations. The update problem associated with the DNC relational schema is easily solved by implementing a WECDIS type corrections layer. This approach to chart update allows deployed units to receive essential update messages by text only message; complete updating of the database can be accomplished on return to harbour in the “normal” fashion. Finally, the previous Canadian commitment to this product could lead to an easier process for changes to the DNC product specification. Integration of the DNC with other DIGEST products, a relatively
simple fix for the update problem, and a previous Canadian commitment to this product support the conclusion that DNC is the best electronic chart product for use in SECDIS.

Future work that is required before SECDIS production can commence includes the development of an effective and efficient contour generation algorithm. Additionally, there remain several tactical capabilities that could be included in SECDIS. However, a description of these requirements is inappropriate in an unclassified report.

This report has highlighted the oversight of dived navigation in the digital era and has provided some direction on how a Submarine Electronic Chart Display and Information System might be developed. SECDIS development must begin immediately if the navigation of Canada’s new submarines is to keep pace with Canada’s surface navy.
References

http://www.chshq.dfo.ca/chs_hq/contour/con_95/c95e03.html. 30 June 1998.


www.osl.com/about/papaers/paper09.html, 10 January 1999.


Appendix A - Charts Produced
Figure A-1 Unregistered Vector Chart

Figure A-2 Registered Vector Chart
Figure A-3 Result of Automatic "Features to Objects"

Figure A-4 Final ENC
Appendix B - Production Workflow
Figure B-1 Digitize Data Workflow (ENC)
Figure B-2 File Preparation Workflow (ENC)
Figure B-3 Digitize Data Workflow (DNC)
Figure B-4 File Preparation Workflow (DNC)
Appendix C – Rectangular Cells?
Rectangular Cells in S-57

Consider the "rectangular" cell bounded by the following coordinates (reference datum NAD-27):

\[
\begin{align*}
\phi & := \begin{bmatrix} 40.00 \\ 40.00 \\ 41.00 \end{bmatrix} \text{deg} & \lambda & := \begin{bmatrix} -61.00 \\ -60.00 \\ -61.00 \end{bmatrix} \text{deg} & h & := \begin{bmatrix} 0 \\ 0 \\ 0 \end{bmatrix} \text{m} \\
\text{Point 1} & = 40\text{N} 061\text{W} & \text{Point 2} & = 40\text{N} 060\text{W} & \text{Point 3} & = 41\text{N} 060\text{W} & \text{Point 4} & = 41\text{N} 061\text{W}
\end{align*}
\]

Now consider a NAD-27 chart that must be transformed to WGS-84. The NAD-27 datum is based on the Clarke 1866 Reference Ellipsoid, while the WGS-84 datum is based on the GRS-80 Reference Ellipsoid. Parameters for each ellipsoid follow:

From the known parameters for the Clarke 1866 Reference Ellipsoid (NAD-27 datum) and the GRS80 Reference Ellipsoid parameters (WGS-84 datum), calculate eccentricities and the prime vertical radius of curvature (N):

\[
\begin{align*}
a_{27} & := 6378206.4 \text{m} & a_{84} & := 6378137.0 \text{m} \\
b_{27} & := 6356583.8 \text{m} & b_{84} & := 6356752.3 \text{m} \\
e_{27} & := \sqrt{\frac{a_{27}^2 - b_{27}^2}{a_{27}^2}} & e_{84} & := \sqrt{\frac{a_{84}^2 - b_{84}^2}{a_{84}^2}} \\
c_{27} & = 0.082 & c_{84} & = 0.082
\end{align*}
\]

\[
\begin{align*}
N_{27} & := \text{for } i \in 1..4 \left( a_{27} \frac{a_{27}^2}{\sqrt{a_{27}^2 \cos(\phi_i)^2 + b_{27}^2 \sin(\phi_i)^2}} \right) \\
N_{84} & := \text{for } i \in 1..4 \left( a_{84} \frac{a_{84}^2}{\sqrt{a_{84}^2 \cos(\phi_i)^2 + b_{84}^2 \sin(\phi_i)^2}} \right)
\end{align*}
\]

\[
\begin{align*}
N_{27} & = \begin{bmatrix} 6387143.945 \\ 6387143.945 \\ 6387517.633 \\ 6387517.633 \end{bmatrix} \text{m} & N_{84} & = \begin{bmatrix} 6386976.172 \\ 6386976.172 \\ 6387345.737 \\ 6387345.737 \end{bmatrix} \text{m}
\end{align*}
\]
Calculate the geocentric Cartesian coordinates in NAD-27

\[
x_{27} := \begin{cases} 
\text{for } i \in 1..4 \\
N(27) + \sum_{i} \sin(\phi_i) \cdot \sin(\lambda_i) 
\end{cases} 
\]
\[
x_{27} = \begin{bmatrix} 
2372094.024 \\
2446418.063 \\
2410360.376 \\
2337131.797
\end{bmatrix} \text{ m}
\]

\[
y_{27} := \begin{cases} 
\text{for } i \in 1..4 \\
N(27) + \sum_{i} \sin(\phi_i) \cdot \cos(\lambda_i) 
\end{cases} 
\]
\[
y_{27} = \begin{bmatrix} 
-4279370.9 \\
-4237320.382 \\
-4174866.635 \\
-4216297.372
\end{bmatrix} \text{ m}
\]

\[
z_{27} := \begin{cases} 
\text{for } i \in 1..4 \\
N(27) + \sum_{i} \cos(\phi_i) \cdot \sin(\lambda_i) 
\end{cases} 
\]
\[
z_{27} = \begin{bmatrix} 
407787.743 \\
407787.743 \\
4162223.955 \\
4162223.955
\end{bmatrix} \text{ m}
\]

WGS-84 Cartesian Coordinates

The origin of the NAD-27 ellipsoid, when expressed in WGS-84 coordinates is the translation vector for all cartesian coordinate tuples.

In this example I have assumed that all misalignment angles are zero (probably an oversimplification)

\[
\Delta X := 35.0 \text{ m} \quad \Delta Y := -146.5 \text{ m} \quad \Delta Z := 170.8 \text{ m}
\]

\[
x_{84} := \begin{cases} 
\text{for } i \in 1..4 \\
x_{84} = x_{27} + \Delta X 
\end{cases} 
\]
\[
x_{84} = \begin{bmatrix} 
2372129.024 \\
2446453.063 \\
2410395.376 \\
2337166.797
\end{bmatrix} \text{ m}
\]

\[
y_{84} := \begin{cases} 
\text{for } i \in 1..4 \\
y_{84} = y_{27} + \Delta Y 
\end{cases} 
\]
\[
y_{84} = \begin{bmatrix} 
-4279517.4 \\
-4237466.882 \\
-4175013.135 \\
-4216443.872
\end{bmatrix} \text{ m}
\]

\[
z_{84} := \begin{cases} 
\text{for } i \in 1..4 \\
z_{84} = z_{27} + \Delta Z 
\end{cases} 
\]
\[
z_{84} = \begin{bmatrix} 
4077958.543 \\
4077958.543 \\
4162394.755 \\
4162394.755
\end{bmatrix} \text{ m}
\]
Using the closed formula, the inverse transformation is solved:

\[
p := \begin{cases} \text{for } i \in 1..4 \\
p_i := \sqrt{\left(x_{84_i}\right)^2 + \left(y_{84_i}\right)^2} \end{cases}
\]

\[
p = \begin{bmatrix} 4892981.227 \\ 4892980.499 \\ 4820865.124 \\ 4820865.851 \end{bmatrix}_{\text{m}}
\]

\[
\alpha := \begin{cases} \text{for } i \in 1..4 \\
\alpha_i := \frac{\left(p_i\right)^2 + a84^2 - e84^4}{1 - e84^2} \end{cases}
\]

\[
\alpha = \begin{bmatrix} 2.41 \times 10^{13} \\ 2.41 \times 10^{13} \\ 2.41 \times 10^{13} \\ 2.41 \times 10^{13} \end{bmatrix}_{\text{m}^2}
\]

\[
\beta := \begin{cases} \text{for } i \in 1..4 \\
\beta_i := \frac{\left(p_i\right)^2 - a84^2 - e84^4}{1 - e84^2} \end{cases}
\]

\[
\beta = \begin{bmatrix} 2.34 \times 10^{13} \\ 2.34 \times 10^{13} \\ 2.34 \times 10^{13} \\ 2.34 \times 10^{13} \end{bmatrix}_{\text{m}^2}
\]

\[
q := \begin{cases} \text{for } i \in 1..4 \\
q_i := 1 + \frac{27 \cdot \left(z_{84_i}\right)^2 \left(\left(q_i\right)^2 - \left(\beta_i\right)^2\right)}{2 \left(\left(z_{84_i}\right)^2 + \beta_i\right)^3} \end{cases}
\]

\[
q = \begin{bmatrix} 1.001 \\ 1.001 \\ 1.001 \\ 1.001 \end{bmatrix}
\]

\[
t_l := \begin{cases} \text{for } i \in 1..4 \\
t_{l_i} := \frac{\left(z_{84_i}\right)^2 + \beta_i}{12} \left[ q_i + \sqrt{\left(q_i\right)^2 - 1} \right]^3 + \beta_i + \frac{\left(z_{84_i}\right)^2}{6} \left[ q_i + \sqrt{\left(q_i\right)^2 - 1} \right]^3 \end{cases}
\]

\[
t_l = \begin{bmatrix} 4.15 \times 10^{12} \\ 4.15 \times 10^{12} \\ 4.33 \times 10^{12} \\ 4.33 \times 10^{12} \end{bmatrix}_{\text{m}^2}
\]
\[ \phi := \begin{cases} \text{for } i \in 1..4 \\
 \frac{z_{84}}{2} + \sqrt{t_{11} + \frac{\beta_1 - \frac{z_{84}^2}{4} - \frac{4 \cdot \alpha_1 \cdot z_{84}}{t_{11}}}{p_i}} \end{cases} \]

\[ \lambda := \begin{cases} \text{for } i \in 1..4 \\
 \lambda_i \leftarrow \text{atan} \left( \frac{y_{84}}{x_{84}} \right) \end{cases} \]

\[ \phi = \left[ \begin{array}{c} 39.9982296534 \\ 39.998233864 \\ 40.998187547 \\ 40.998183251 \end{array} \right] \text{deg} \quad \lambda = \left[ \begin{array}{c} -61.0004732261 \\ -60.000502808 \\ -60.000510329 \\ -61.000480305 \end{array} \right] \text{deg} \]

**In DMS...**

Point 1 = 39 59' 53.627"N 061 00' 01.704"W  
Point 2 = 39 59' 53.641"N 060 00' 01.810"W  
Point 3 = 40 59' 53.475"N 060 00' 01.837"W  
Point 4 = 40 59' 53.460"N 061 00' 01.729"W

**Not "Rectangular"**

Using one minute of latitude = 1852m, we find:

\[ \text{DEG}_{\text{lat}} := 60 \cdot 1852 \text{m} \quad \text{DEG}_{\text{long}} := (\cos(\text{mean}(\phi))) \cdot \text{DEG}_{\text{lat}} \]

\[ \text{DEG}_{\text{lat}} = 11112\text{m} \quad \text{DEG}_{\text{long}} = 84498.56\text{m} \]

\[ \Delta \phi_{21} := \left( \phi_2 - \phi_1 \right) \frac{180}{\pi} \]

\[ \text{dnorth} := | \Delta \phi_{21} \cdot \text{DEG}_{\text{lat}} | \]

\[ \text{dnorth} = 0.468\text{m} \]

\[ \frac{\text{DEG}_{\text{long}}}{\text{dnorth}} = 180598.98 \]

Thus point 2 is 46.8cm north of point one after transformation, or a change of one part in 180 thousand.
Appendix D – VPF Table Structures
Tables in this Appendix support the discussion in § 4.3. Mandatory / optional requirements for use of a column is designated by a bold face letter at the end of the column description using the following convention:

- **O** – Optional
- **OF** – Optional Feature Pointer, used to show that direct pointers to feature table are desired to improve performance.
- **M** – Mandatory
- **M<n>** - Mandatory at n topology level, n = 1...3

**Table D-1 Isolated/Connected Node Primitive Table**

<table>
<thead>
<tr>
<th>ID</th>
<th>*.PFT_ID</th>
<th>Containing Face</th>
<th>First edge</th>
<th>Coordinates</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unique Record ID (Primary Key)</td>
<td>Optional Pointer to associated feature table</td>
<td>Pointer to face table for face containing isolated nodes</td>
<td>Pointer to Edge table for connected nodes</td>
<td>Node coordinates</td>
</tr>
<tr>
<td>M</td>
<td>OF</td>
<td>M3/null</td>
<td>M1-3/null</td>
<td>M</td>
</tr>
</tbody>
</table>

**Table D-2 Edge Primitive Table**

<table>
<thead>
<tr>
<th>ID</th>
<th>*.LFT_ID</th>
<th>Start Node</th>
<th>End Node</th>
<th>Right Face</th>
<th>Left Face</th>
<th>Right Edge</th>
<th>Left Edge</th>
<th>Coordinates</th>
</tr>
</thead>
<tbody>
<tr>
<td>Primary Key</td>
<td>Optional Pointer to associated feature table</td>
<td>Pointer Connected Node Table</td>
<td>Pointer Connected Node Table</td>
<td>Pointer Face Table</td>
<td>Pointer Face Table</td>
<td>Pointer to Right Edge</td>
<td>Pointer to Left Edge</td>
<td>Coordinate Information for drawing edge</td>
</tr>
<tr>
<td>M</td>
<td>OF</td>
<td>M1-3</td>
<td>M1-3</td>
<td>M3</td>
<td>M3</td>
<td>M1-3</td>
<td>M1-3</td>
<td>M</td>
</tr>
</tbody>
</table>

**Table D-3 Face Primitive Table**

<table>
<thead>
<tr>
<th>ID</th>
<th>*.AFT_ID</th>
<th>RING_PTR</th>
</tr>
</thead>
<tbody>
<tr>
<td>Primary Key</td>
<td>Optional Pointer to associated feature table</td>
<td>Pointer to the outer ring in a ring table</td>
</tr>
<tr>
<td>M3</td>
<td>OF</td>
<td>M3</td>
</tr>
</tbody>
</table>

**Table D-4 Ring Table**

<table>
<thead>
<tr>
<th>ID</th>
<th>FACE_ID</th>
<th>START_EDGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Primary Key</td>
<td>ID of Face the Ring is associated with</td>
<td>Pointer to edge table for one edge in the ring</td>
</tr>
<tr>
<td>M3</td>
<td>M3</td>
<td>M3</td>
</tr>
</tbody>
</table>
### Table D-5 A Simple Feature Table

<table>
<thead>
<tr>
<th>ID</th>
<th>TILE_ID</th>
<th>*_ID</th>
<th>Attribute(s)</th>
<th>FROM_TO</th>
</tr>
</thead>
<tbody>
<tr>
<td>Primary Key</td>
<td>Identifies the tile where feature belongs</td>
<td>Pointer to the Primitive Table, the * is a placeholder for the primitive table name</td>
<td>Provides attribute description</td>
<td>Defines Line Feature Orientation as “Same As” or “Opposite” to primitive orientation</td>
</tr>
<tr>
<td>M</td>
<td>M (if tiled)</td>
<td>M</td>
<td>M (at least one attribute)</td>
<td>O</td>
</tr>
</tbody>
</table>

### Table D-6 Join Table

<table>
<thead>
<tr>
<th>ID</th>
<th>*_ID</th>
<th>TILE_ID</th>
<th>*_ID</th>
<th>FROM_TO</th>
</tr>
</thead>
<tbody>
<tr>
<td>Primary Key</td>
<td>Provides ID of the first table in the join</td>
<td>Identifies the tile where feature belongs</td>
<td>Provides ID of the second table in the join, usually a primitive table</td>
<td>Defines Line Feature Orientation as “Same As” or “Opposite” to primitive orientation</td>
</tr>
<tr>
<td>M</td>
<td>M</td>
<td>M (if tiled)</td>
<td>M</td>
<td>O</td>
</tr>
</tbody>
</table>

### Table D-7 Feature Class Schema Table

<table>
<thead>
<tr>
<th>ID</th>
<th>FEATURE_CLASS</th>
<th>TABLE1</th>
<th>TABLE1_KEY</th>
<th>TABLE2</th>
<th>TABLE2_KEY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Primary Key</td>
<td>Name of allowable feature class</td>
<td>Name of first table in relationship</td>
<td>Table 1 column used in relationship</td>
<td>Name of second table in relationship</td>
<td>Table 2 column used in relationship</td>
</tr>
<tr>
<td>M</td>
<td>M</td>
<td>M</td>
<td>M</td>
<td>M</td>
<td>M</td>
</tr>
</tbody>
</table>

### Table D-8 Value Description Table

<table>
<thead>
<tr>
<th>ID</th>
<th>Table</th>
<th>Attribute</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Primary Key</td>
<td>Name of feature table</td>
<td>Name of column in feature table being described</td>
<td>The unique attribute value, either text code or an integer</td>
<td>Plain language description</td>
</tr>
<tr>
<td>M</td>
<td>M</td>
<td>M</td>
<td>M</td>
<td>M</td>
</tr>
</tbody>
</table>
Appendix E – SECDIS Product Specification
E.1 Pool of Error Generation in SECDIS

1. The DR/EP capabilities of SECDIS shall take course input from one of any of the submarine’s gyros (only one to be selected at a time). A secondary mode shall be available where the course is keyed in by the operator, and as a tertiary method, course made good between GPS fixes shall be used and displayed (surfaced / periscope depth only). A GPS course made good display for the helmsman is desirable (useful if all gyros fail).

2. The speed input is from any of the selected logs (only one shall be selected at a time). As a secondary method, the operator shall be able to key in the speed, and as a tertiary method, speed made good between GPS fixes shall be used / displayed (surfaced / periscope depth only).

3. Tidal stream / ocean current data shall be keyed in and automatically applied to the DR to generate an EP (with conventional symbols). When using tidal stream information, a tidal stream variation model shall be used to account for spatial and temporal tidal stream variations.

4. The DR/EP shall be continually generated and displayed; it is the reference point for the pool of errors.

5. The pool of errors must be capable of interacting with other chart data. Just as current ECDIS systems provide alarms for numerous safety reasons, the pool of errors must also trigger these and other alarms (to be discussed later).

6. Pool of error parameters are normally given by the submarine’s captain after consultation with the navigating officer. These parameters shall include log error (as
a percentage), gyro error, fix error (in yards or metres), and percent of tidal stream to be applied along track and across track. These entries shall be password protected.

7. The pool of errors shall be continually updated and displayed.

8. An alarm should sound if a fix places the submarine outside the pool of errors.

9. SECDIS shall be able to display the true and relative bearings from own submarines estimated position to selected fixing points.

10. SECDIS shall be able to disable the pool of errors function for surfaced navigation.

E.2 Safe Depth Contours in SECDIS

1. The system shall interpolate the contour (not just round up to the next depth contour).

2. The system shall incorporate a “sensitivity” function, so that when contours are drawn, not every sounding becomes a polygon. At the other extreme the system shall identify “outliers”, so that safe depth polygons do not become excessively distorted to incorporate a single sounding that might be considered an anomaly.

3. The system shall check for errors by ensuring that all soundings are bounded by the appropriate safe depth contour.

4. SECDIS shall be capable of drawing these contours “on-the-fly”.

5. The operator shall be able to choose bottom safety margin, this quantity will be able to be reduced below current doctrine.

6. The operator shall be able to use speed to define the bottom safety margin criteria, having safe depth contours redrawn in accordance with current doctrine.

7. The pool of errors shall interact with safe depth contours and provide a distinct audible alarm when the safe depth contour is crossed.

8. The safe depth contours shall be able to be turned off for surface navigation.
9. SECDIS shall display current safe depth.

**E.3 WSM in SECDIS**

This section makes recommendations on how waterspace management considerations should be handled within SECDIS. Recommendations are broken down into four categories as follows:

1. Recommendations that apply all categories;
2. Recommendations that apply to established exercise areas;
3. Recommendations that apply to temporary areas; and
4. Recommendations that apply to transit lanes.

**E.3.1 General WSM Recommendations**

1. The system shall be capable of generating a user selectable buffer inside the area boundary (a redundant safety practice);
2. The system shall, at time of data entry, prompt the operator for any depth restrictions, these restrictions shall be displayed;
3. Any coordinate entries shall be in the form of degrees, minutes, and decimal minutes; and
4. The pool of errors shall interact with both the area buffer and area boundary; either interaction shall sound an audible alarm.

**E.3.2 Exercise Area Recommendations**

1. The operator shall be able to select appropriate areas by point-and-click;
2. This action shall result in a prompt for times that the area is available (mandatory field) and depth restrictions (optional field);
3. The current authorized area(s) shall have a highlighted border with colour to be selectable from a few appropriate colours;

4. Next available area shall have a highlighted border of different colour, available colours shall be configured so that similar (or identical) colours cannot be chosen for both current and next available areas; and

5. Time remaining within the current area shall be an optional display, this display shall also show distance to the next operator selected area and speed required to arrive at that area prior to current area “expiring”.

E.3.3 Temporary Exercise Area Recommendations

1. Temporary areas shall be able to be generated by either point and click or by keying in coordinates;

2. Temporary areas shall be able to be saved as an additional military layer and then reused on other charts of different scales;

3. The operator shall be able to enter times that the area is available (mandatory field) and depth restrictions (optional field);

4. The current area shall have a highlighted border with colour to be selectable from a few appropriate colours; and

5. Time remaining within the current area shall be an optional display, this display shall also show distance to the next operator selected area and speed required to arrive at that area prior to current area “expiring”.

116
E.3.4 Transit Lane Recommendations

1. The operator shall be able to key in latitude and longitude for each waypoint;
2. The operator shall be able to input arrival time for each waypoint;
3. The dimensions of the moving haven shall be operator selectable;
4. The system shall support moving haven size changes at any point within a passage;
5. Depth/diving restrictions within a moving haven shall be displayed;
6. The position of the submarine relative to the centre of the moving haven shall be an optional display;
7. Speed required to the next waypoint shall be an optional display;
8. Speed required to the final waypoint shall be an optional display;
9. In addition to speed of advance calculations (i.e. given the time constraints, calculate the speed required), the system shall be capable of providing estimated times of arrival for any speed input; and
10. The moving haven shall alter course and interact with temporary/established exercise areas in accordance with current doctrine.

E.4 LOP Recommendations

1. SECDIS shall be capable of operating in “LOP mode”. In this mode, navigation calculations shall continue, all navigation alarms remain active, but the display shall be able to suppress navigation data;
2. New LOPs shall be able to be assigned a unique file name and saved;
3. SECDIS shall be capable of printing LOPs, charts, and chart segments. A SECDIS viewer software should be developed for use as a post analysis tool. Use of this type of software would revolutionize submarine records management;

4. The system shall have separate monitors for navigation and LOP information. These monitors shall be able to operated at different scales, and the user shall be able to display LOP information on the navigation display (at the correct scale). Should sufficient space not be available, the system shall be capable of cycling between the navigation display and LOP display without affecting data on either display. The last scale/zoom factor selected in either mode shall be used as the display scale for both modes;

5. SECDIS LOPs shall use symbols in accordance with The Submarine Combat Information Handbook;

6. Own submarine shall start at the centre of the display, however the operator shall be able to offset own position relative to the display centre by point and click. All LOP data shall be redrawn relative to new “own submarine” position;

7. The scale shall be operator selectable with minimum scale as 500 yards to the inch, and maximum scale of 4000 yards to the inch;

8. Scale shall be changeable on-the-fly, and scale changes shall preserve and redraw appropriate data (i.e. all data that fits on the new display) at the new scale;

9. A sonar input window shall allow the operator to input target number, bearing, range (optional field for active sonar/radar data), make remarks (i.e. solutions from other sources), and select a time interval between inputs.
10. The inputted bearing shall be time tagged to the nearest second, extended the full extent of the display, and once a solution is assigned, reduced in length to 2cm either side of target track;

11. The system shall display countdown to next input for each contact, this should be displayed near the most recent bearing line associated with the contact in question;

12. The operator shall be able to select the colour of the bearing lines so that each contact can be uniquely identified;

13. The contact number shall be prominently displayed, in the same colour as the bearing lines, near the extreme of the most recent sonar bearing;

14. A visual input window shall allow the operator to input target number, bearing, range, ATB and remarks;

15. Given a single visual setup (bearing, range, ATB), the system shall generate and display target course;

16. Given two visual setups, the system shall calculate and display target course and speed between the looks, additionally the difference between the course between the looks and the course generated by the ATB shall be calculated and displayed;

17. Given three target setups, the system shall calculate and display target course, speed between the last two looks, speed overall, and mean speed (where speed overall is defined as the speed between the first and last setup, and mean speed is an average of all speed between looks);

18. Courses generated with three or more data points shall use a Least Squares Estimate of the line of best fit through the data points. This algorithm shall identify outliers and allow the operator to discard these points;
19. The system shall be capable of conducting TMA on the bearing lines via “digital multi-point dividers”. These dividers shall be able to be set at a given speed (distance between points), and manipulated within the display to achieve a suitable solution;

20. The operator shall be able to assign several solutions. Once assigned, the system shall: generate and display target DRs (at operator specified interval), calculate and display target course, speed, distance off track, closest point of approach, and time to CPA for each solution.

21. A “zig procedure” window shall allow the operator to enter time of the zig, target speed after the alteration, bearing update interval (default 1 minute), and number of concentric circles to display (default 5);

22. The system shall generate and display the concentric circles centred on the time of alteration (this time need not be coincident with a displayed DR);

23. The system shall calculate and display the two possible courses after the first bearing is input;

24. The system shall calculate and display the two possible courses after each subsequent bearing input and provide the operator the option to choose and assign one of the solutions. Assigning a solution shall terminate the zig procedure; and

25. Additional capabilities associated with LOP/weapon operations shall also be included, but are considered beyond the scope of an unclassified paper.